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SEMESTER -V 

CC-X FUNDAMENTALS OF INFORMATION TECHNOLOGY 

SUB.CODE: THEORY-18UCO10 

PRACTICAL-18UCO10P 

Objective:  To  make  the  student  to  understand  the  fundamentals  of  information  technology  to 
acquire the practical knowledge in MS – office.  

UNIT – I 

Introduction to  Computers: Definition, Characteristics and  limitations of computers  –Elements of 
computers – Hardware – CPU – Primary and Secondary memory – Input and Output devices.  IT  
enabled  Services  –  BPO,  KPO,  Call  centers.  Modern  Communication  (Concepts Only):  FAX,  
Voice  mail,  and  information  services  –  E  mail  –  Creation  of  e-mail  id  –  Group communication  
–  Tele conferencing  –  Video conferencing  –Network types LAN, MAN, WAN and their architecture 
– Dial up access. 

UNIT – II  

MS Word & Word Processing: Meaning and features of word processing  –  Advantages and  
applications  of  word  processing  –  Parts  of  MS  Word  application  window  –  Toolbars  –Creating,  
Saving  and  closing  a  document  –  Opening  and  editing  a  document  –  Moving  and copying  text  
–  Text  and  paragraph  formatting,  applying  Bullets  and  Numbering  –  Find  and Replace –  
Insertion of Objects Date and Time, Headers, Footers and Page Breaks  –  Auto Correct –  Spelling and 
Grammar checking  –  Graphics, Templates and wizards  –  Mail Merge: Meaning, purpose and 
advantages – creating merged letters, mailing  lables, envelops and catalogs. 

UNIT – III 

MS Excel: Features of Ms Excel  –  Spread sheet/ worksheet, workbook, cell, cell pointer, cell  address  
etc.,  -  Parts  of  MS  Excel  window  –  Saving,Opening  and  Closing  workbook  –Inspection  and  
Deletion  of  worksheet  –  Entering  and  Editing  data  in  worksheet  –  cell  range  –Formatting  –  
Auto  Fill  –  Formulae  and  its  advantages  –  References:  Relative,  absolute  and mixed –  Functions: 
Meaning and Advantages of functions, different types  of functions available in Excel – Templates – 
Charts – Graphs – Data Sorting. 

UNIT – IV 

MS  Access:    Data,  Information,  Database,  File,  Record,  Fields  –  Features,  Advantages and  
Limitations  of  MS  Access  –  Application  of  MS  Access  –  Parts  of  MS  Access  window  –Tables, 
Forms Queries and Reports – Data validity checks. 
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UNIT – V 

MS Power Point: Features, advantages and application of MS Power Point  – Parts of MS Power  Point  
window  –  Menus  and  Tool  Bars  –  Creating  presentations  through  Auto  content wizard, 
Templates and manually  –  Slide show  –  Saving, Opening and Closing a Presentation  –Inserting, 
editing and deleting slides  –  Types of slides –  Slide views  –  Formatting  –  Insertion of objects and 
Charts in Slides – Custom Animation and Transition. 

LAB WORK: 

PRACTICALS: 

MS WORD,     MS EXCEL,     MS ACCESS,   MS POWERPOINT 

60 Marks Theory 40 MarksPractical 

Theory:  Pattern:- External 45  Internal 15 

Practical:  Exam -30      Record Note – 10 

 

UNIT-I 

Computer: 

Meaning: 

          It is an electronic device for storing and processing data, typically in binary form, according to 
instructions given to it in a variable program. A person who makes calculations, especially with a 
calculating machine. 
          A computer is a machine that can be instructed to carry out sequences of arithmetic or logical 
operations automatically via computer programming. Modern computers have the ability to follow 
generalized sets of operations, called programs. These programs enable computers to perform an 
extremely wide range of tasks .Computer, device for processing, storing, and displaying information. 

Characteristics of Computer  
The main characteristics of computer are the following below: 

• Speed  
• Accuracy 
• Diligence 
• Reliability 
• Versatility 
• Storage Capacity 
• Automatic 
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• Quick Decision 
• Multitasking 
• No Feeling 
• Power of Remembering 
•  No IQ  

 
 

 

 

Limitations of Computer 

• No Self-Intelligence. Computer does not have intelligence of its own to complete the tasks. 
They give wrong output if the input given by humans are wrong. 

• No Thinking and Decision Making Power. The computer cannot think itself. 
• No Feeling. Lack of feeling is another limitation of computer. 

Four elements of computer 

1. Hardware 
2. Software 
3. Data 
4. User 

 

 

Hardware 

Computer Hardware is any part of the computer that can be touched. These are primarily electronic 
devices used to build up the computer. Computer Hardware actually perform the computing operations 
along with taking input and sending the computed result as output or to storing that. Processor, Memory 
Devices, Monitor, Printer etc. are computer hardware. Monitor is used to display output such as video, 
texts etc. while Printer is used to print documents, images etc. These are electronic devices and can be 
touched. Both monitor and printer are output devices. 
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Software 

Software, by definition, is a collection of computer programs, procedures and documentation that 
performs different tasks on a computer system. Software can specify the processors instruction through 
which the processor can change the state of computer hardware in a predefined sequence. Briefly, 
computer software is a language in which computer speaks. There are various types of software to do 
various tasks. Operating Systems such as Microsoft Windows 10, Word processing applications such 
Microsoft Word etc. as computer software. We can’t touch these as they are all virtual. But we can use 
them using various input devices and can get output from them using different output devices. For 
example, we can use keyboard to type into Microsoft Word and can see what we types in the monitor, 
we can also print out what we typed using a printer.  

Data 

One or a set or multiple sets of information used in a process to obtain targeted result or goal are called 
data. In other words, pieces of information which by itself may or may not be meaningful but useful 
when connected or used with other pieces of information to form a piece of information that are 
meaningful, are called data. There are various differences between data and information. An information 
generated by processing a set of data can be used as data for another process. Data is primarily of two 
types, numeric data and non-numeric data. However, data can be of various types such as numbers, 
texts, images etc. 

Users 

The person who uses the computer is the user. However, beside human, another device can become user 
of a computer too. No only another device but also a software or program can be treated as a user. 
Actually, anyone or anything who or which uses, instructs or operates the computer to compute is an 
user of the computer. 

Functions of Computer  

1. Program Execution 
2. Input 
3. Processing 
4. Output 
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Program Execution 

Among the 5 key parts in micro-computer, there are  memory and storage devices in it for storing data 
and executable codes. Generally large set of data is stored in storage devices such as hard disk drives 
etc. When instructed, computer loads executable data from storage to memory devices such as RAM etc. 
and executes them. Computer executes instructions in several steps. 

Input 

Though a computer can be operated from stored scheduled set of instructions, but those are not general 
purpose computers. General purpose computers are supposed to take instructions or inputs from its 
users. The devices which are used to input data or signal or instruction to computer are called input 
devices such as keyboard, mouse etc. Computer performs tasks based on input from user along with 
performing other tasks which might not be required any further input or instructions. 

 

Processing 

The processing of data is totally depended on what the user want and what the instructions are supposed 
to do with the data. For example, if user wanted add 4 and 5, the computer performs this simple math as 
per the instructions and also outputs as per the instruction. The task that a computer do in between 
taking input and sending back output, is processing 
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Output 

When computer finishes processing data as per instructions, it outputs the data back. However, its not 
obvious that the output will occur as the instruction could be to store the result of processing in storage 
device, or use the result of processing as input for the next processing etc. Computer uses various 
hardware devices such as monitor, speaker, printer etc. to output information. 

Difference between Hardware and Software 

 

Computer Hardware: 
Hardware refers to the physical components of a computer. Computer Hardware is any part of the 
computer that we can touch these parts. These are the primary electronic devices used to build up the 
computer. Examples of hardware in a computer are the Processor, Memory Devices, Monitor, Printer, 
Keyboard, Mouse, and the Central Processing Unit. 
Computer Software: 
Software is a collection of instructions, procedures, documentation that performs different tasks on a 
computer system. we can say also Computer Software is a programming code executed on a computer 
processor. The code can be machine-level code or the code written for an operating system. Examples of 
software are Ms Word, Excel, Power Point, Google Chrome, Photoshop, MySQL etc. 
 

 

Difference Between Hardware and Software: 

HARDWARE SOFTWARE 

Hardware is a physical parts 

computer that cause processing of 

data. 

Software is a set of instruction that 

tells a computer exactly what to do. 

It is manufactured. It is developed and engineered. 

Hardware can not perform any task 

without software. 

software can not be executed 

without hardware. 

As Hardware are physical 

electronic devices, we can see and 

We can see and also use the 

software but can’t actually touch 
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HARDWARE SOFTWARE 

touch hardware. them. 

It has four main categories: input 

device, output devices, storage, and 

internal components. 

It is mainly divided into System 

software, Programming software 

and Application software. 

Hardware is not affected by 

computer viruses. 

Software is affected by computer 

viruses. 

It can not be transferred from one 

place to another electrically 

through network. But, it can be transferred. 

If hardware is damaged, it is 

replaced with new one. 

If software is damaged, its backup 

copy can be reinstalled. 

Ex: Keyboard, Mouse, Monitor, 

Printer, CPU, Hard disk, RAM, 

ROM etc. 

Ex: Ms Word, Excel, Power Point, 

Photoshop, MySQL etc. 

Primary and Secondary: 

The most basic distinction is between types of computer memory is between primary memory - 
often called system memory - and secondary memory, which is commonly called storage. 

      Computer memory is a generic term for all of the different types of data storage technology that a 
computer may use, including RAM, ROM, and flash memory. 
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         Some types of computer memory are designed to be very fast, meaning that the central processing 
unit (CPU) can access data stored there very quickly. Other types are designed to be very low cost, so 
that large amounts of data can be stored there economically. 

       Another way that computer memory can vary is that some types are non-volatile, which means they 
can store data on a long term basis even when there is no power. And some types are volatile, which are 
often faster, but which lose all the data stored on them as soon as the power is switched off. 

    A computer system is built using a combination of these types of computer memory, and the exact 
configuration can be optimized to produce the maximum data processing speed or the minimum cost, or 
some compromise between the two. 

       Although many types of memory in a computer exist, the most basic distinction is between primary 
memory, often called system memory, and secondary memory, which is more commonly called storage. 

The key difference between primary and secondary memory is speed of access. 

• Primary memory includes ROM and RAM, and is located close to the CPU on the computer 
motherboard, enabling the CPU to read data from primary memory very quickly indeed. It is 
used to store data that the CPU needs imminently so that it does not have to wait for it to be 
delivered. 

• Secondary memory by contrast, is usually physically located within a separate storage device, 
such as a hard disk drive or solid state drive (SSD), which is connected to the computer system 
either directly or over a network. The cost per gigabyte of secondary memory is much lower, but 
the read and write speeds are significantly slower. 

Input Device: 

          An input device is essentially a piece of hardware that sends data to a computer. Most input 
devices either interact with or control the computer in some way. The most common input devices are 
the mouse and the keyboard, but there are many others. The key distinction between an input 

device and an output device is that the former sends data to the computer, whereas the 
latter receives data from the computer. Input and output devices that provide computers with additional 
functionality are also called peripheral or auxiliary devices. 

10 Examples of Input Devices 

1. Keyboard 
2. Mouse 
3. Touchpad 
4. Scanner 
5. Digital Camera 
6. Microphone 
7. Joystick 



10 

 

8. Graphic Tablet 
9. Touch Screen 
10. Webcam 

Each device in this list is covered in more detail below. 

1. Keyboard 

        Keyboards are the most common type of input device. Before keyboards, interaction with 
computers was generally carried out using punch cards and paper tape. Most English language 
keyboards use the QWERTY layout for the alphabetic keys, which are surrounded by number, symbol, 
function, and other key types. By pressing the relevant keys, a user can feed data and instructions to the 
computer. 

2. Mouse 

       A mouse interacts with a computer through a process known as "point and click." Essentially, when 
a user moves the mouse on the mouse pad, the pointer moves in a corresponding direction on the 
computer's monitor screen. The concept of a computer mouse has its roots in the trackball, a related 
pointing device invented in 1946 that used a "roller ball" to control a pointer. Most modern computer 
mice have two buttons for clicking and a wheel in the middle for scrolling up and down documents and 
web pages. 

3. Touchpad 

     Also known as a trackpad, a touchpad is a common substitute for a computer mouse. It is essentially 
a specialized surface that can detect the movement of a user's finger and use that information to direct a 
pointer and control a computer. Touchpads were first introduced for laptops in the 1990s, and it's now 
rare to find a laptop without one. 

4. Scanner 

       The word "scanner" can be used in a number of different ways in the computer world, but here I am 
using it to refer to a desktop image scanner. Essentially, a scanner is an input device that uses optical 
technology to transfer images (or sometimes text) into a computer, where the signal is converted into a 
digital image. The digital image can then be viewed on a monitor screen, saved, edited, emailed, or 
printed. 

5. Digital Camera 

       Digital cameras are used to capture photographs and videos independently. Later, these photo and 
video files can be transferred to a computer by connecting the camera directly with a cable, removing 
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the memory card and slotting it into the computer, or through wireless data transfer methods such as 
Bluetooth. Once the photos are on the computer, they can be saved, edited, emailed, or printed. 

6. Microphone 

      A microphone captures audio and sends it to a computer where it is converted to a digital format. 
Once the audio has been digitized, it can be played back, copied, edited, uploaded, or emailed. 
Microphones can also be used to record audio or to relay sounds live as part of a video chat or audio 
stream. 

7. Joystick 

      Joysticks are commonly used to control characters and vehicles in computer video games. 
Essentially, a joystick is a handle that pivots on a base and sends its angle or direction to the computer as 
data. Many video gaming joysticks feature triggers and buttons that can be pressed to use weapons or 
projectiles in games. 

8. Graphic Tablet 

     Also known as digitizers, graphic tablets are input devices used for converting hand-drawn artwork 
into digital images. The user draws with a stylus on a special flat surface as if they were drawing on a 
piece of paper. The drawing appears on the computer screen and can be saved, edited, or printed. While 
scanners can only create digital images from drawings, graphic tablets offer greater control and 
versatility for artists by allowing them to see their drawing appear live on their monitor as they create it. 

9. Touch Screen 

     Many devices nowadays use a touch screen rather than a mouse as a way for users to point, drag, or 
select options on a screen. As the name suggests, a touch screen is a touch-sensitive monitor screen that 
reacts to fingers moving across it. Touch screens are particularly common in portable devices, such as 
tablets, palmtops, laptops, and smartphones. 

10. Webcam 

    Webcams are different from digital cameras in two ways. Firstly, they cannot operate independently 
from a computer, and second, they have no inbuilt memory. Although webcams can capture photographs 
and videos, they are more often used to live-stream videos or facilitate video chats. 
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Output Device  

An output device is a piece of computer hardware that receives data from a computer and then translates 
that data into another form. That form may be audio, visual, textual, or hard copy such as a printed 
document. 

The key distinction between an input device and an output device is that an input device sends data to 
the computer, whereas an output device receives data from the computer. 

For example, using a microphone to record a podcast is an example of using an input device. Listening 
to the recorded podcast through a connected speaker is an example of using an output device. Both 
output and input devices are examples of auxiliary or peripheral devices. 

Analyzing the Functionality of a Device 

             There are four different categories of output device: visual, data, print, and sound. Each output 
device example has a specific history, so here I cover specifically how each device works, when it 
became a part of technology history, popular brands on the market selling the device, and a fun fact. 

10 Examples of Output Devices 

1. Monitor 
2. Printer 
3. Headphones 
4. Computer Speakers 
5. Projector 
6. GPS 
7. Sound Card 
8. Video Card 
9. Braille Reader 

     10.      Speech-Generating Device 
1. Monitor 

Mode: Visual 

Function: A monitor consists of a screen, circuitry, a power supply, buttons to adjust screen settings, 
and a casing that contains all of these components. A monitor displays data from a computer onto a 
screen so the user can interact with the data via a digital interface. 

Popular Brands: Acer, Alienware, Apple, Asus, Dell, HP, LG, Lenovo, Samsung 
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Origin Story: The first monitors used the same technology as early televisions, relying on a cathode ray 
tube and a fluorescent screen. This technology was first utilized for computer monitors in 1965 in the 
Uniscope 300 machine, which had a built-in CRT display. CRT display lights up a series of dots with a 
beam on an active part of the screen. This resulted in a maximum resolution of 1600 by 1200 pixels. 
LCD (liquid crystal display) entered the market in 2000 and outsold CRT monitors in 2007. Nowadays, 
monitors incorporate flat display technology. Plasma monitors are brighter than both CRT and LCD and 
function by illuminating tiny charged gas bubbles, or plasma, in the screen. 

Fun Fact: VDT (video display terminal) and VDU (video display unit) are alternative names for 
monitors. 

2. Printer 

Mode: Print 

Function: The function of a printer is to create a copy of whatever is sent from the computer to the 
printer. Printers take electronic data sent from a computer and generate a hard copy. 

Popular Brands: Brother, Canon, Epson 

Origin Story: Photocopying, also known as xerography, is the origin-technology of modern-day 
printing and was invented in 1938 by Chester S. Carlson of Queens, New York. 

The first inkjet printer was developed in 1951. There are many different types of printers, with inkjet 
and laser printers being two of the most common. Modern printers usually connect to a computer with a 
USB cable or via Wi-Fi. 

Fun Fact: A plotter, which is also a type of print output device, is a similar type of hardware device to a 
printer. Unlike a printer, however, plotters use writing tools, such as pen, pencil, marker, to draw lines. 
Designed to use vector graphics, plotters were once commonly employed for computer-aided design, but 
have now been largely replaced by wide-format printers. 

3. Headphones 

Mode: Sound 

Function: Headphones output audio from a computer through two individual headphones for a single 
listener. Also known as earphones, headphones allow you to listen to audio without disrupting other 
people in the vicinity. 

Popular Brands: Sennheiser, JBL, Bose, Sony, Skullcandy 
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Origin Story: There’s no single figure who invented headphones, but the use of headphones stems from 
the military. Nathaniel Baldwin of Utah submitted a headphone prototype to the U.S. Navy in 1910, 
which was adopted some years after by Naval radio operators. Koss Corporation then created the first 
commercial stereo headphones in 1958. Nowadays, headphones come in all shapes and sizes, from basic 
earbuds to the traditional style with padding around the earpieces and a connecting band that fits over 
the user's head. 

Fun Fact: Headphones were popularized for mainstream use in 1979 by Sony Walkman. 

4. Computer Speakers 

Mode: Sound 

Function: Computer speakers are hardware devices that transform the signal from the computer's sound 
card into audio. Speakers create sound using internal amplifiers that vibrate at different frequencies 
according to data from the computer. This produces sound. 

Popular Brands: Audioengine, Logitech, Razer, Harman 

Origin Story: Speakers are essential if you want a louder sound, surround sound, fuller bass, or just 
higher quality audio. The first internal computer speaker (a speaker inside the chassis of a laptop) was 
created in 1981 by IBM. External computer speakers began to appear in stores in the early 1990s when 
computer gaming, digital music, and other forms of media became popular. Some computer speakers are 
wireless nowadays, connecting to the computer via Bluetooth. 

Fun Fact: You can turn your speakers (or headphones!) into a microphone. The difference between 
computer speakers and a microphone is that the frequency of the vibration originates from external 
sounds rather than data from a computer. 

5. Projector 

Mode: Visual 

Function: As its name suggests, this output device "projects" computer images or video onto a wall or 
screen. 

Popular Brands: BenQ, Sony, Optoma, Epson 

Origin Story: Originally, projectors weren’t an output device. Projectors were first created and used in 
late 19th-century France. Throughout history, biunial lanterns were used to project ink on glass by 
photographers, lecturers, and magicians. A biunial lantern is a lantern with projection capabilities. 
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"Biunial" means combining two things into one, so a biunial lantern is a directional lantern and a glass 
slide with a print on it for projecting. 

In the early 1920s, filmstrips were used to show “films” in classrooms. Turning the knob allowed 
teachers to stop on specific slides. Clear film copies for projectors weren’t invented until the 1960s, and 
3M became the leading producer in clear film and projectors. 

The data projector was invented in 1980. This is the first year it was considered an “output device.” The 
data projector was the first rendition of the projector that was closest to modern-day. Using a single 
cathode ray tube (CRT), the first data projector projected only monochromatically. 

Nowadays, projectors are typically used for presentations, watching movies, or as a teaching aid, as they 
enable an entire roomful of people to see images generated by a single computer. Modern projectors 
usually connect to the computer via an HDMI (high-definition multimedia) cable or VGA (video 
graphics array) cable. 

Fun Fact: 3D projectors are designed to project two images of the same thing from different angles at 
the same time. Wearing 3D glasses, the viewer can see a 3D projection composed of multiple 
superimposed images. 

6. GPS (Global Positioning System) 

Mode: Data 

Function: GPS is a radio-based navigation system that’s composed of a sender computer and a receiver. 
The sender broadcasts signals to 24 satellites that ping to the sender the exact location of the sender 
computer in the form of latitude and longitude coordinates. The satellites use microwave signals to 
“talk” to the GPS, giving information on location, vehicle speed, and a number of other pieces of data. 

Popular Brands: Magellan, Garmin, TomTom 

Origin Story: A Soviet-era technology, GPS was originally used in the 1960s to track U.S. submarines 
carrying nuclear missiles. The Department of Defense deployed more satellites to bolster the burgeoning 
navigation system. By 1993, 24 satellites were in orbit and GPS was used broadly across the world in 
agriculture, aviation, the military, athletics, science, and the list goes on. 

Fun Fact: Until May 1st, 2000, high-quality GPS signals were confined for use by the government. 

7. Sound Card 

Mode: Sound 
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Function: The sound card controls the output of sound signals, enabling devices like speakers and 
headphones to work. The sound card is known as an expansion card, which means it can be added to the 
motherboard. Although a sound card is not essential to a computer's basic functionality, you need one if 
you wish to play games, watch movies, listen to music, and use audio and video conferencing. 

Popular Brands: Audigy, ASUS, Creative, EVGA 

Origin Story: The first sound card was invented by Sherwin Gooch in 1972 and was used in PLATO 
systems (Programmed Logic for Automatic Teaching Operations). PLATO was the first computer-
assisted learning system in widespread use. It wasn't until 1988 that sound cards were widely used in 
PCs. 

When computer data is sent through a sound card, it is sent to the card digitally. The sound card then 
translates the digital information (in the form of binary, or 0s and 1s) into analog information: 
vibrations, output in the form of sound. 

Fun Fact: The popularization of sound cards originated in the gaming realm. Sierra Entertainment, a 
gaming platform, began supporting add-ons like sound cards and this enabled the sound card industry to 
grow without being an underground solution to a growing issue: shallow sound while gaming. 

8. Video Card 

Mode: Visual 

Function: As with the sound card, the video card is an expansion card that slots into the motherboard. 
The video card processes images and video, enabling visuals to be seen on a display. Most computers 
have basic video and graphics capabilities built into the computer's motherboard, but for faster, more 
detailed graphics, a video card is required. 

Popular Brands: NIVIDIA, ASUS, MSI, EVGA 

Origin Story: Video cards are also known as GPUs or graphics processing units. Before modern-day 
GPUs, IBM introduced the MDA (monochrome display adapter). The MDA supported visuals such as 
text and lines for uses such as drafting but didn't offer any graphical experiences. 

In order to increase the functionality of the burgeoning computing technology, Hercules Computer 
Technology invented the Hercules Graphics Card, which integrated with the MDA to offer a bitmapped 
(or "rasterized," or pixelated), graphics experience. From the 1990s on, graphics technology was 
increasingly like modern-day graphics cards and has increased in graphic quality and speed significantly 
since then. 
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Fun Fact: Video cards can work in both 2D images and 3D images. Images like browsers, computer 
desktops, and PDFs are considered 2D images, whereas computer games are considered 3D. 

9. Braille Reader 

Mode: Print 

Function: A braille reader is a peripheral device that enables a blind person to read text displayed on a 
computer monitor. The text is sent by the computer to the device, where it is translated into a braille 
format and made readable by pushing rounded pins up through a flat surface. Braille readers are also 
called braille displays and come in various sizes. Braille readers come in the form of separate devices 
from a keyboard or as part of a keyboard. Most use piezoelectric technology, or electricity generated by 
mechanical stress, to create a single line of text at a time in the form of raised bumps. 

This was the case until late 2018 when Blitlab proposed an electronic solution to the limited capabilities 
of braille readers. Blitlab, upon its release, will allow the visually impaired to use the internet and read 
books and newspapers more independently. The technology is still in development. The device will cost 
only around $500, which is little compared to traditional braille readers, which cost around $5,000 to 
$11,000. 

Popular Brands: ALVA, Handy Tech, Freedom Scientific, BrailleNote 

Origin Story: Braille is a 63 character alphabet invented in 1824 by Louis Braille. Braille was 
embossed on paper and other materials for decades before braille reader technology was invented. The 
first braille output technology was patented in 1975 by the Schönherr Company, and braille reader 
technology has evolved slowly since. 

Fun Fact: Blitlab is the first tablet-style braille reader technology that will utilize a perforated glass 
screen that raises bumps as the computer reads the text from websites and translates it to braille. 

10. Speech-Generating Device (SGD) 

Mode: Sound 

Function: SGDs, also known as voice output communication aids, generate text to speech. A user types 
something and when the command is sent, the SGD reads the sentence out loud. 

Popular Brands: DynaVox, Luminaud, ZYGO Industries, Inc. 

Origin Story: The first version of the SGD used print output. The “patient-operated selector 
mechanism,” or POSSUM, found symbols on a display and illuminated them for the reader. In the 1980s 
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Dynavox was formed by students from Carnegie Mellon University with the goal to make an effective 
SGD for a young woman with cerebral palsy. This resulted in the invention of the EyeTyper, a device 
that allowed the user to spell with their eyes that would then be spoken. 

Fun Fact: The most famous use of an SGD was by Stephen Hawking. Hawking was an astrophysicist 
with Lou Gehrig’s disease (also known as ALS). Lou Gehrig’s disease slowly deteriorates nerves in the 
spine and brain that results in gradual loss of muscle control. This often includes the ability to speak. 

Other Output Device Examples: 

• Computer Output Microfilm (COM, or Microfiche): COM is used to create a film image of the page 
sent from a computer. 

• Plotter: A plotter interprets vector graphics files and draws lines between points. 
• Television: A television (TV) is fed video and sound data which is output to the user in the form of 

synchronized sound and pictures. 
 
Devices That Both Output and Input Data: 

• Modem: A modem sends and receives information over a telephone line or cables. 
• Touch Screen: Touch screens accept input in the form of touch and display the output from the 

computer. 
• Network Card (NIC): A network card is an expansion card for a computer that allows the device to 

connect to the network or internet. 

Output Device Knowledge: An Evolving Topic 

The variety and complexity of output devices evolve with technology. Conceptually output devices have 
existed for decades. The biunial lantern, for example, sufficed in lieu of a more advanced option for 
projecting pictures; most output devices (like projectors) as they are known today didn't come into 
widespread use until the popularization of computer use at home in the 1980s. 

 

Information Technology Enabled Services (ITeS) 

IT enabled Services (ITeS), also called web enabled services or remote services or Tele-working, 
covers the entire gamut of operations which exploit information technology for improving efficiency of 
an organization. These services provide a wide range of career options that include opportunities in call 
Centre, medical transcription, medical billing and coding, back office operations, revenue claims 
processing, legal databases, content development, payrolls, logistics management, GIS (Geographical 
Information System), HR services, web services etc.[1] 

 
Information Technology that enables the business by improving the quality of service is IT enabled 
services. The most important aspect is the Value addition of IT enabled service. The value addition 
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could be in the form of - Customer relationship management, improved database, improved look and 
feel, etc. The outcome of an IT enabled service is in the two forms: 

• Direct Improved Service 
• Indirect Benefits.  

Whereas direct benefits can be realized immediately, indirect benefits can accrue over a period of time, 
and can be harnessed very effectively, if planned well upfront. 

 

 
source: IT Info 

 
Information Technology Enabled Services (ITeS) Processes and Services 
ITeS provide a range of IT-intensive processes and services, which includes business process 
outsourcing (BPO) and knowledge process outsourcing (KPO), provided from a distant location and 
delivered over telecom networks. ITeS focus on verticals such as content management, finance and 
accounts, research and analytics segment. ITeS includes: 

• Customer Interaction services -including call center facilities with adequate telecom infrastructure, 
trained consultants, access to requisite databases, Internet and other online information 
infrastructure to provide information and support to customers 

• Back office operations -data entry, data conversion including finance and accounting and HR 
services. 

• Transcription/Translation services 
• Content development/animation/engineering/design and GIS 
• Other services including remote education, data search, market research, network consultancy and 

management 
The favoured application areas are areas where there is huge amount of data that needs to be processed 
and utilised for delivering the results, or the data is the outcome of the service. In all cases, without use 

օf IT the task would otherwise be unmanageable. Some of the most important areas where IT enabled 

services can be deployed are: 

• Telemarketing 
• Helpdesk 
• Customer Support Centres 
• Data Ware House 
• Transcription Centres 
• GIS Mapping for Transport tracking 
• Electronic Distribution. 
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Opportunities and Challenges of Information Technology Enabled Services (ITES)  
The changing economic and business conditions, rapid technological innovation, proliferation of 
the internet and globalization are creating an increasingly competitive environment. The role of 
technology has evolved from supporting corporations to transforming them. Global companies are 
increasingly turning to offshore technology service providers in order to meet their need for high quality 
and cost competitive technology solutions. As such a company can encounter a wide variety of risks and 
challenges in their endeavor to create and maintain a seamless, successful, sustainable and scalable 
business. Some of the challenges faced include: 

• Ability to create and maintain a truly world class proven global delivery model which would allow 
your organization to provide services to customers on a best shore basis. This would require round 
the clock execution capabilities across multiple time zones, access to a large pool of highly skilled 
technology professionals and a knowledge management system to reuse solutions where 
appropriate 

• Develop and expand a strong, comprehensive, best in class end to end solutions and service 
offerings in order help your clients gain market differentiation or competitive advantage and thus 
capture a greater share of your client’s technology budgets 

• Ability to scale when the opportunity arises. This would require constant investment in 
infrastructure and rapidly recruit, train and deploy new professionals 

• Manage revenue and expenses during economic downturn, enhance your organization’s capacity to 
withstand pricing pressures, commoditization of services and decreased utilization rates 

• Manage exchange rate volatility and counter party risk in treasury operations 
• Expand your client list across business verticals to reduce over dependency and risk of losing 

substantial market share 
• Maintain superior and sophisticated project management methodology in line with global quality 

standards and ensure timely, consistent and accurate execution to achieve highest client satisfaction 
• Ensuring successful integration of inorganic growth opportunities that your organization may 

undertake from time to time across geographies 
 
12 Factors Which Have Propelled the Growth of the Indian ITES Sector 
India is regarded as the back office of the world owing mainly to its IT and ITES industry. The sector in 
India grew at a Compound Annual Growth rate (CAGR) of 15 per cent over 2010-15, which is 3-4 times 
higher than the global IT-ITES spend, and is estimated to expand at a CAGR of 9.5 per cent to US$ 300 
bn by 2020. India is also the world's largest sourcing destination for the information technology 
(IT) industry, accounting for approximately 67 per cent of the US$ 124-130 bn market. With the rising 
influence of online shopping, social media and cloud computing, this trend will only further increase. 
Some of the most important factors behind India's rise as an IT information technology services giant 
include - 

• Newly emerging verticals, such as retail, healthcare, utilities, etc. 
• A revival in the demand for IT services from both US and Europe 
• Focused government initiatives leading to an increased adoption of technology and telecom, 

eventually leading to increased ICT adoption 
• Growth in the number of high-value clients (> $1million) 
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• A spurt in the SMAC market (social, mobility, analytics, cloud) to support ITES services 
• Growing R&D expenditure across the globe 
• Rising costs to train new workforce ($1.6 billion in 2016) 
• Plan of the Indian government to lay down a large-scale optical fiber network connecting the whole 

country 
• Partial privatization of telecommunication 
• Low operating costs as compared to most other developed and developing nations 
• Tax breaks and SOPs offered by the government 
• Development of multiple SEZs in tier-2 cities across the country 

Benefits and Threats of ITeS
: 

• BENEFITS: 
                        Increases company’s flexibility: Through Business Process Outsourcing 
(BPO) which is a part of ITeS the companies will increase their flexibility. Most services provided 
by ITeS vendors are offered on a feefor-service basis. This helps the company to change their 
structure of cost from Fixed to Variable cost. A variable cost helps a company to respond to 
changes very quickly and make the firm more flexible through outsourcing. One more way in 
which ITeS contributes to a company’s flexibility is that a company focuses on its core 
competencies, without any burdens from bureaucratic restraints. With this main employees are 
released from performing non-core operations or administrative processes and can spend more time 
and energy in building the firm’s main businesses. Another way in which ITeS increases 
organizational flexibility is by increasing the speed of business processes. Using techniques such as 
linear programming we can decrease the production time and inventory levels, which can increase 
effectiveness and controls or decreases cost. Supply chain management (SCM) with the effective 
use of chain partners and business process outsourcing increases the speed of several business 
processes. Lastly, flexibility is one of the stages of organizational life cycle. ITeS helped to convert 
Nortel from a bureaucratic organization to a very reliable competitor. ITeS therefore helps the firms 
to retain their speed and ability, which they have to otherwise sacrifice in order to become efficient. 
A company grows at a faster rate as it will be less constrained by large capital expenditures for 
people or equipment which may take years together to gradually write-off the cost. Though the 
above-mentioned arguments are in favor of ITeS and increases the flexibility of organizations, 
management needs to be very careful with the implementation of it. The company has to look into 
the challenges before it decides to engage in business process outsourcing. Another issue is that in 
many cases there is less scope to differentiate BPO from other with size. They provide same 
services, have same geographic footprints, same technology stacks, and have same Quality 
Improvement approaches. 

• THREATS: 
                       Risk is the major threat with ITeS. Outsourcing an Information system, can cause 
security risks both from part of communication and from privacy. The Security of North American 
or European company data is very difficult when accessed or controlled in the Sub-Continent. From 
the perspective of knowledge, a change in attitude in employees, underestimation of present costs 
and the major risk of losing independence, outsourcing leads to a different relationship between 
organizations. Risks and threats of outsourcing can be managed, to achieve any benefits. If we are 
able to manage outsourcing in a structured way, maximizing positive outcome, minimizing risks 
and avoiding any threats, a Business Continuity Management (BCM) model arises. 
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Business Process Outsourcing: 
         Business process outsourcing (BPO) is a method of subcontracting various business-related 
operations to third-party vendors. Although BPO originally applied solely to manufacturing entities, 
such as soft drink manufacturers that outsourced large segments of their supply chains, BPO now applies 
to the outsourcing of services, as well. 

Business Process Outsourcing (BPO) is the contracting of a specific business function, such as customer 
support, marketing, etc. It should not be confused with the concept of outsourcing as a whole, though. 
The difference is that with BPO, you outsource an entire business function (all of lead generation, for 
example), rather a single job (think, hiring a VA from a developing country). 

The processes outsourced, however, are rarely the core ones. After all, if it’s something critical to 
company success, you really wouldn’t trust a contractor doing it. You’re more likely to benefit from 
outsourcing support roles, such as customer relations. This way, your team back home can focus more 
on your core functions, rather than trying to learn new skills. This is, at the end of the day, a win-win. 
Instead of having to start a customer support team from scratch, you’re giving the job to a company that 
specializes in it – and you’ll end up spending less, to boot. 

In terms of outsourcing functions, there’s back office and front office. Back office includes internal 
company processes – accounting, purchasing, etc. The front office, on the other hand, is anything that 
deals with customers: sales, customer support, and so on. 

There are 3 different types of outsourcing: 

Offshore – Outsourcing in a distant country. Think, USA to China. This usually means very significant 
cost-cutting, since the salaries in developing countries can be 8x cheaper than in the US. 

Nearshore – For countries that are located close to the contracting company. Think, USA to Mexico. 

Onshore – Outsourcing within the same country but a different city or location. The main value here is 
still cutting costs, while maintaining the added benefit of your employees being native, cutting out 
chances for miscommunication. Lyft, for example, is moving its support team from San Francisco to 
Nashville, where living costs (and accordingly, salaries) are 3-4x times cheaper. 

Business Process Outsourcing Benefits 

There are a lot of benefits for business process outsourcing, given that you manage to find the right 
partner company. 

Some of the benefits include… 

Lowered Costs 

The most popular and talked-about benefit for outsourcing is the significantly lower expenses. 
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Depending on where you’re sourcing, prices can be slightly lower (Think, San Francisco to Nashville), 
or significantly (development from San Francisco to India). Other than the lower salaries, there’s the 
added benefit of getting a “tax break.” While the government doesn’t straight-off give you a tax break, 
you get the option to defer paying income tax on profits made abroad. 

Focus on Core Functions & Improved Support 

If you’re an up-and-coming software startup, you really can’t be bothered with starting a huge customer 
support team from scratch. While doing it right is important, chances are, in-house isn’t the best place 
for that. If your founding team has a technical background, they won’t be as good in training a support 
team. So, by outsourcing to a company that specializes in support, you end up with better processes at 
the same price. 

This, in turn, allows your team to focus on what’s important for the company – the core processes that 
make the company stand out. 

Global Expansion 

If you decide to enter the French market, for example, you’d be having a very difficult time getting 
started. First of all, you can’t just import your American sales team because of the language barrier. So, 
you’d have to send someone from company management to start a regional department. This, in turn, 
leads to some other issues – even if the company official is fluent in the language, they’re unlikely to 
know how the market in that specific country works. 

So, instead, it’s easier to find a local partner company with a native workforce. They’re already aware of 
how the market works, as well as having the knowledge of the language and culture on their side. And, 
of course, you can manage the 3rd party company as much as needed. 

Business Process Outsourcing Risks 

At a glance, outsourcing might seem to be hard to pass on. After all, you end up getting higher quality 
service in exchange for lower costs. The thing with outsourcing is, though, that you really have to get it 
right. Otherwise, you’re opening yourself up to significant risks. 

Outsourcing a specific job function is pretty simple – you find a capable enough employee online and 
get them to work. If it doesn’t work out, you can always just replace them. 

When outsourcing business processes, though, it’s not always that simple. You become highly 
dependant on a local company on a lot of your operations, and if you’re not careful with choosing the 
right partner, you might have some problems: 
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Dependence on a Foreign Company 

Unlike a single employee, it’s significantly harder to cut ties with a company. Once you’ve outsourced 
your processes, the other company becomes an integral part of your operations. Meaning, if they start 
underperforming, there wouldn’t be a lot you could do. If you fire them, you’d have to invest a lot in 
switching companies – you’d have to re-orient the employees in the new company. 

Hidden Expenses & Time Waste 

Selecting a vendor isn’t a simple matter – it can take a lot of effort on your end for due diligence, and up 
to a year of your time to actually get the initiative started. You can also end up wrapping yourself up in 
unwanted expenses – while a developer in India can be 10x cheaper than one in the US, it doesn’t mean 
that you’ll be saving nearly as much. 

To get a proper estimation of the real cost, you’d need to consider the cost of your management team’s 
time spent on picking the right vendor, as well as anyone else involved in the process. This can be a 
while, taking up t0 500 hours. Then there’s a whole chunk of other misc. expenses – legalities, vendor-
search, outside BPO consultant, etc. 

Security Risks 

While you might have state-of-the-art security back home, with an unpenetrable office building, your 
partner company might not be nearly as good. While in the western world, security is a very major 
factor, it is less so in the developing countries. Hence, you’d have to be careful about what system 
privileges you’re giving to the outsourced company, or invest more money in exchange for a more 
expensive company. 

Communication Issues 

If you’re outsourcing some business-critical function, the language barrier might turn out to be a 
problem. With support services, this is rarely the case, since you interact with company management, 
specifically. If you’re outsourcing development, on the other hand, your CTO might have to work with 
five developers with sub-par English. The developers might be highly skilled, but mistakes due to 
miscommunication can turn out to be very costly. 

Knowledge Process Outsourcing (KPO) 

Knowledge Process Outsourcing (KPO) means information related business task or knowledge-based 
processes such as research, analysis, consultancy or any other high-level task are outsourced i.e. done by the 
workers of another company or allocated to the subsidiary of the same organization. 

These subsidiaries can be in different countries or geographical location. This is done in order to save 
resources and costs. KPO firms can take decisions of businesses on the behalf of the parent companies. 
KPO is nothing but the subset of Business Process Outsourcing (BPO). 
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Cost-effectiveness, access to the best talent, focus, better utilization of the resources are the advantages of 
Knowledge Process Outsourcing (KPO). Let us learn about KPO in greater detail. 

Knowledge Process Outsourcing (KPO) is when difficult, high-level tasks get outsourced by a company to 
a vendor. So the activities which the company will be outsourcing are core activities. 

They require skills, technical knowledge, and expertise. So a company outsources these tasks to another 
company (vendor) or a subsidiary company located in the same country or sometimes offshores for cost 
purposes. 

As we know, BPO services are also the outsourcing of activities, but non-core activities. So a KPO will be a 
subset of a BPO. However, KPO involves more core activities with specialized and technical work. 

The company outsources to KPO’s for their skilled labor and subject expertise, not to lower their work 
burden. It is also an opportunity to lower costs because, in developing countries like India, skilled and 
educated labor is a lot cheaper. 

So a KPO is like an umbrella, it covers a variety of activities. So there are many types of KPO’s 
like market research, legal discovery, financial research, pharma and biotech, data analytics, creative 
design, technical content writing etc. 

As it happens India is one of the leading providers of many of these KPO services, especially in the 
technical and scientific fields. It is currently a $14 billion industry in India. 

Some famous companies providing such KPO services in India are Wipro, TCS, WNS Global, Aditya Birla 
Minacs etc. And still, this sector continues to grow at a very fast pace. But in recent years India is facing 
huge competition from countries like China, the Philippines, and the Czech Republic etc. 

 

List of KPO Companies in India 

• Sutherland Global Services 

• WNS 

• Boston Analytics 

• SG Analytic 

• Eclerx 

• Syntel 
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• CRISIL 

• iGate 

• McKc (Mckinsey Knowledge Centre) 

• Deloitte 
Advantages of KPO 

1. Cost-effectiveness: One of the biggest advantages of a KPO is obviously the cost advantage. The 
company does not have to set up any infrastructure or bear any operational or running costs. And it 
gets effective, expertizes services at a fraction of the cost. 

2. Access to the best talent: KPO’s provide the company with the best, most knowledgeable and 
skilled professionals available in the global talent pool. And if the KPO is in a 
developing country like India or Philippines then the cost of such talent is also relatively low. 

3. Focus: Outsourcing some of the processes, allows the company to focus on its core functions. The 
KPO handles the peripheral functions, and the company can better focus on its core functions and 
improve their efficiency and results. 

4. Better Utilization of Resources: If the company outsources the process that is not at the core of their 
business strategy, it can use the resources it saves in better places. Say a company outsources its 
supply chain management. Then the resources it saves on this can be utilized to streamline the 
manufacturing process, R&D activities, better marketing etc. a company to a vendor. So the activities 
which the company will be outsourcing are core activities. 

They require skills, technical knowledge, and expertise. So a company outsources these tasks to another 
company (vendor) or a subsidiary company located in the same country or sometimes offshores for cost 
purposes. 

As we know, BPO services are also the outsourcing of activities, but non-core activities. So a KPO will be a 
subset of a BPO. However, KPO involves more core activities with specialized and technical work. 

The company outsources to KPO’s for their skilled labor and subject expertise, not to lower their work 
burden. It is also an opportunity to lower costs because, in developing countries like India, skilled and 
educated labor is a lot cheaper. 

So a KPO is like an umbrella, it covers a variety of activities. So there are many types of KPO’s 
like market research, legal discovery, financial research, pharma and biotech, data analytics, 
creative design, technical content writing etc. 

As it happens India is one of the leading providers of many of these KPO services, especially in the 
technical and scientific fields. It is currently a $14 billion industry in India. 
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Some famous companies providing such KPO services in India are Wipro, TCS, WNS Global, Aditya Birla 
Minacs etc. And still, this sector continues to grow at a very fast pace. But in recent years India is facing 
huge competition from countries like China, the Philippines, and the Czech Republic etc. 

  Disadvantages   of KPO: 

• Lack of confidentiality 

• Risk of leaking of sensitive data and private financial information 

• The possibility of hidden costs (especially in offshore outsourcing) 

Call centre: 

It is centralized office used for the purpose of receiving or transmitting a large volume of request by 
telephone. 

 

 

E-Mailing: 

           E-mailing, short for “electronic mail”, is one of the most widely used features of the internet, along 
with the web. It allows you to send and receive messages to and from anyone with an e-mail address, 
anywhere in the world. 

callcentre

insurance

banking  

and 

financial

research 

analytics

travel 

ticketing

logisticshealthcare

telegram

mortgage

HR & 

recruiting
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Creation of e-mail id: 

       Creating  E-mail address with google.com. select  the E-mail service provider�Enter 
http://www.google.com. 

1. Choose a user ID 

2. Choose a password 

3. Confirm password 

4. Hint question 

5. Hint answer 

6. Name 

7. Sex 

8. E-mail address(if already have) 

9. Address 

10. City 

11. District 

12. State 

13. Country 

14. Zip 

15. Education 

16. Occupation 

17. Income 
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18. SET AND RESET  buttons 

19. Other needed information 

 

 

Modern communication: 

  Fax: 

             Fax is the telephonic transmission of scanned printed material normally to a telephone number 
connected to a printer or to another device of exists. 

Voice mail: 

         A voice mail system (also known as voice message or voice bank) is a computer based system that 
allows users and subscribers to exchange personal voice messages; to select and deliver voice information; 
and to process transactions relating to individuals, organizations, product and services, using an ordinary 
telephone. 

Information services: 

         An IS (Information Services) is this Part of an information system that serve data / knowledge 
information to customers and collects it from it contributors, to manage and store it by optionally using 
administrators. An information service is a service which provides (serves) data/ knowledge /information 
somehow. 

Group  Communication: 

    Tele conferencing: 

             A teleconferencing is a telephone meeting among two or more participants involving technology 
more sophisticated than a simple two-way phone connection. At its conference with one or both end of the 
conference sharing a speaker phone. 

 



 

Video conference: 

       A video conference is a live. Visual connection between two or more people residing in separate 
locations for the purpose of communication. At its simplest video conferencing provides transmission of 
static images and text between two locations. At 
motion video images and high quality audio between multiple locations.  

Types of Computer Network: LAN, MAN and WAN

There are mainly three types of computer n
1. Local Area Network (LAN) 
2. Metropolitan Area Network (MAN)
3. Wide area network (WAN) 

1. Local Area Network (LAN)
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A video conference is a live. Visual connection between two or more people residing in separate 
locations for the purpose of communication. At its simplest video conferencing provides transmission of 
static images and text between two locations. At its most sophisticated it provides transmission of full
motion video images and high quality audio between multiple locations.   

Types of Computer Network: LAN, MAN and WAN 

There are mainly three types of computer networks based on their size: 

2. Metropolitan Area Network (MAN) 

1. Local Area Network (LAN) 

 

A video conference is a live. Visual connection between two or more people residing in separate 
locations for the purpose of communication. At its simplest video conferencing provides transmission of 

its most sophisticated it provides transmission of full-

 



 

 1.Local area network is a group of computers connected with each other in a small places 
such as school, hospital, apartment etc.
2. LAN is secure because there is no outside connection with the local area network thus the 
data which is shared is safe on the local area network and can’t be accessed outside.
3. LAN due to their small size are considerably faster, their speed can range anywhere 
100 to 100Mbps.
4. LANs are not limited to wire connection, there is a new evolution to the LANs that allows 
local area network to work on a wireless connection.

 

2. Metropolitan Area Network (MAN)

     MAN network covers larger area by connections LANs to a larger network of computers. In 
Metropolitan area network various Local area networks are connected with each other through telephone 
lines. The size of the Metropolitan area network is larger th
networks), a MANs covers the larger area of a city or town.
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Local area network is a group of computers connected with each other in a small places 
such as school, hospital, apartment etc.

secure because there is no outside connection with the local area network thus the 
data which is shared is safe on the local area network and can’t be accessed outside.
3. LAN due to their small size are considerably faster, their speed can range anywhere 
100 to 100Mbps.
4. LANs are not limited to wire connection, there is a new evolution to the LANs that allows 
local area network to work on a wireless connection. 

2. Metropolitan Area Network (MAN) 

MAN network covers larger area by connections LANs to a larger network of computers. In 
Metropolitan area network various Local area networks are connected with each other through telephone 
lines. The size of the Metropolitan area network is larger than LANs and smaller than WANs (wide area 
networks), a MANs covers the larger area of a city or town. 

Local area network is a group of computers connected with each other in a small places 
such as school, hospital, apartment etc. 

secure because there is no outside connection with the local area network thus the 
data which is shared is safe on the local area network and can’t be accessed outside. 
3. LAN due to their small size are considerably faster, their speed can range anywhere from 
100 to 100Mbps. 
4. LANs are not limited to wire connection, there is a new evolution to the LANs that allows 

 

MAN network covers larger area by connections LANs to a larger network of computers. In 
Metropolitan area network various Local area networks are connected with each other through telephone 

an LANs and smaller than WANs (wide area 



 

3. Wide area network (WAN) 

 

Wide area network provides long distance transmission of data. The size of the WAN is larger than LAN 
and MAN. A WAN can cover country, continent or even a whole world. Internet connection is an 
example of WAN. Other examples of WAN are mobile broadband connections such as 3G, 4G etc.

Advantages of WAN: 

Centralized infrastructure: One of the main advantage of WAN is the tha
backup and store data on local system as everything is stored online on a data centre, from where we can 
access the data through WAN. 

Privacy: We can setup the WAN in such a way that it encrypts the data that we share onlin
data is secure and minimises the risk of unauthorized access.

Increased Bandwidth: With the WAN we get to choose the bandwidth based on the need, a large 
organization can have larger bandwidth that can carry large amount of data faster and e

Area: A WAN can cover a large area or even a whole world though internet connection thus we can 
connect with the person in another country through WAN which is not possible is other type of 
computer networks. 

Disadvantages of WAN: 

Antivirus: Since our systems are connected with the large amount of systems, there is possibility that we 
may unknowingly download the virus that can affect our system and become threat to our privacy and 
may lead to data loss. 
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Wide area network provides long distance transmission of data. The size of the WAN is larger than LAN 
cover country, continent or even a whole world. Internet connection is an 

example of WAN. Other examples of WAN are mobile broadband connections such as 3G, 4G etc.

Centralized infrastructure: One of the main advantage of WAN is the that we do not need to maintain the 
backup and store data on local system as everything is stored online on a data centre, from where we can 

Privacy: We can setup the WAN in such a way that it encrypts the data that we share onlin
data is secure and minimises the risk of unauthorized access. 

Increased Bandwidth: With the WAN we get to choose the bandwidth based on the need, a large 
organization can have larger bandwidth that can carry large amount of data faster and e

Area: A WAN can cover a large area or even a whole world though internet connection thus we can 
connect with the person in another country through WAN which is not possible is other type of 

nce our systems are connected with the large amount of systems, there is possibility that we 
may unknowingly download the virus that can affect our system and become threat to our privacy and 

 

Wide area network provides long distance transmission of data. The size of the WAN is larger than LAN 
cover country, continent or even a whole world. Internet connection is an 

example of WAN. Other examples of WAN are mobile broadband connections such as 3G, 4G etc. 

t we do not need to maintain the 
backup and store data on local system as everything is stored online on a data centre, from where we can 

Privacy: We can setup the WAN in such a way that it encrypts the data that we share online that way the 

Increased Bandwidth: With the WAN we get to choose the bandwidth based on the need, a large 
organization can have larger bandwidth that can carry large amount of data faster and efficiently. 

Area: A WAN can cover a large area or even a whole world though internet connection thus we can 
connect with the person in another country through WAN which is not possible is other type of 

nce our systems are connected with the large amount of systems, there is possibility that we 
may unknowingly download the virus that can affect our system and become threat to our privacy and 
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Expensive: Cost of installation is very high. 
Issue resolution: Issue resolution takes time as the WAN covers large area, it is really difficult to pin 
point the exact location where the issues raised and causing the problem. 

Interconnection of Networks: 
We have read LAN, MAN and WAN above, we also talked about internet. You can say that an internet 
is a combination of LAN, MAN and WAN. 

Dial-up Internet access  

             Dial-up Internet access is a form of Internet access that uses the facilities of the public switched 
telephone network (PSTN) to establish a connection to an Internet service provider (ISP) by dialing 
a telephone number on a conventional telephone line. Dial-up connections use modems to decode audio 
signals into data to send to a router or computer, and to encode signals from the latter two devices to 
send to another modem. 

Microsoft Word or MS Word (often called Word) is a graphical word processing program that users 
can type with. It is made by the computer company Microsoft. Its purpose is to allow users to type and 
save documents. 

Similar to other word processors, it has helpful tools to make documents. 

• Spelling & grammar checker, word count (this also counts letters and lines) 

• Speech recognition 

• Inserts pictures in documents 

• Choice of typefaces 

• Special codes 

• Web pages, graphs, etc. 

• Tables 

• Displays synonyms of words and can read out the text 

• Prints in different ways 

      Microsoft Word is a word processor, which means that it's designed primarily for text-based 
documents. ... In Word, you type text and see roughly how it will appear on someone else's 
computer screen or on paper. You can change the font, color, size and other style settings for text 
using Word's built-in options. 

Features in Microsoft Word: 

           The word processor has many unique features as follows : - 

1) Typing easy : In MS WORD typing is so easy because 

a. We need not click enter button after end of the line as the type writer. The word processor 

itself takes matter to the next line of the document. This facility is called word wrapping 

b. There is no limit for typing the matter 
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c. You can easily correct mistakes as the typing matter appears on the screen 

2) Saving: The document type can be stored for future use. We can preserve the document for any 

number of years in word processing 

 

 

3) Adding, removing and applying text : Documents can be modified easily in MS office we can 

easily place a new word in place of existing one. The new words will automatically be adjusted in the 

place of deleted or modified text. We can also copy a part or whole of the matter from one document to 

another document 

 
4) Spell check of words : The spelling of the words in the document can be rectified automatically we 

can also find alternative words to our typed words. The grammatical errors can also be rectified in word 

processor. 

5) Change the style and shape of characters and paragraph : 

The documents in word processor can be made attractive because the shape and style of characters in 

the documents can be changed according to our requirement 

6) Bullets and Numbering : 

Bullets are special symbols which can be put for different points, paragraphs and documents where as 

numbers are ascending figure while 1,2,3 etc. 

7) Headers and footers : A header is the text appearing above the documents and footer is the text 

appearing below the documents 

8) Creation of tables : If you give directions for required number of rows and columns word provides a 

ready made table to work 

9) Inserting pictures and objects : In the word processor we can insert the pictures in the document to 

make it more attractive. These pictures can be obtain from clip art which is available in word processor 

10) Preview facility : Before getting a print out of our document we can get a preview of document if 

mistakes are there we can change the document 

11) Mail merge facility : If you want to send information to different persons there is a facility in word 

processor known as mail merge the main body of the letters can be typed once and we can send the same 

to different addresses 

12) Macros : With the help of macros we can avoid certain type of repetitive works. This saves our time 

and efforts. 

 

Advantages : 

 

1) Quality: Word produces error free documents. The spell and grammar check in word processing 

makes the document to be error free. 

2) Storage of text: We can take any number of copies with word processor. If we need this same 

document with slight changes we need not type the same letter again just by making some slight changes 

we can obtain a modified copy easily. 



35 

 

3) Time saving : We can get any number of copies of documents in future without re typing 

4) Securities: We can protect the documents of word by giving pass word. 

5) Dynamic exchange of data: We can have dynamic exchange of objects and pictures from other 

documents into word processing document. The documents can be linked each other. 

Word Processing 

Word Processing refers to the act of using a computer to create, edit, save and print documents. In order 
to perform word processing, specialized software (known as a Word Processor) is needed. One example 
of a Word Processor is Microsoft Word, but other word processing applications are also widely used. 
Examples include: Microsoft Works Word Processor, Open Office Writer, Word Perfect and Google 
Drive Document.. 

These programs allow users to create a wide variety of documents including (but certainly not limited 
to) reports, letters, memos, newsletters and brochures. In addition to typing text, the word processor 
allows you to add content such as pictures, tables, and charts to your documents as well as decorative 
items including borders and clipart. 

The editing and formatting capabilities of the word processor 
demonstrate the application's true power. Text can be inserted, 
edited, moved, copied or deleted within your document and the 
appearance of the text can be modified in numerous ways. Most 
word processors also give your the ability to check your spelling 
and grammar and many have built in dictionaries and other tools 
to assist you in your writing. 

The remainder of this lesson will introduce you to a few 
of the basic concepts and functions of Word Processing and then 
provide you with links to tutorials which will assist you in 
expanding your skills using Microsoft Word, the standard word 
processing software application at Broome Community College. 

 

Parts of ms word application window: 

The basics of the Word window 

Let's briefly review the basic parts of the Word XP window before we move onto word processing. 

Shown below is the Microsoft Word default window. When Word is launched, a new blank document—

or default window—opens in Print Layout view. Although window elements are fully explained in our 

Windows course, here is a brief explanation of the Word window. 
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Title bar 

This displays the document name followed by a program name. 

Menu bar 

This contains a list of options to manage and customize documents. 

Standard toolbar 

This contains shortcut buttons for the most popular commands. 

Formatting toolbar 

This contains buttons used for formatting. 

Ruler 

This is used to set margins, indents, and tabs. 
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Insertion point 

This is the location where the next character appears. 

End-of-document marker 

This indicates the end of the document. 

Help 

This provides quick access to Help topics. 

Scroll bars 

These are used to view parts of the document. 

Status bar 

This displays the position of the insertion point and working mode buttons. 

Task pane 

This provides easy access to commonly used menus, buttons, and tools. 

View buttons 

These change the layout view of the document to normal, web layout, print layout, and outline view. 

Office Assistant 

This links to the Microsoft Office Help feature. 

Change in view 
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In an effort to provide various ways in which to view your work in progress and remain organized, 

Word XP offers five views for your document. The five views are normal, print layout, web layout, 

outline, and full screen. 

Normal view is best used for typing, editing, formatting and proofreading. It provides a maximum 

amount of space without rulers or page numbers cluttering your view. 

Web Layout view shows what your text will look like on a webpage. 

Print Layout view shows what your document will look like when it is printed. Under Print Layout 

view, you can see all elements of the page. Print Preview shows you this as well. 

Outline view is used to create and edit outlines. Outline view only shows the headings in a document. 

This view is particularly handy when making notes. 

Full Screen view displays ONLY the document you are working on. All other pieces of the Word 

window are removed except for one button that allows you to close the view screen. 

Changing your document view: 

• Click View on the menu bar. 

• Select the view of your choice. 
 

 
 

OR 

• Click one of the four buttons at the bottom-left of your Word window (View Full Screen 
is not available in this location). 
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Drop-down menus 

Each Office XP program features a menu bar. The menu bar is made up of different menus. Each menu 

contains commands that enable you to work within the program. 

 

If you have used a previous version of Microsoft Word, you may notice that the menu bar in Word XP 

operates slightly differently than before. 

 

Word XP uses drop-down menus that initially display commands users most often need. 

Operating the new drop-down menus 

To open a menu: 

• Click a menu name on the menu bar. 

• View the commands listed under the drop-down menu. 

• With the menu open, drag the mouse pointer to a command and click it to select the 
command. (As you drag your mouse pointer over the commands, each command is 

highlighted in light blue.) 
 

 

• If there is a small black triangle next to a command, hover the mouse pointer over the 
command with the triangle and a cascading menu with additional options will appear. 

Point and click to make a selection from the cascading menu. 
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• Commands that are not used often in XP are initially hidden from the viewer. If you do not 
see all of the commands on a menu, click the double arrows at the bottom of the drop-

down menu. You can also double-click the menu to expand it. 
 

 

Using the task pane 

The task pane is new in Word XP. When opened, the task pane will appear on the right side of the 

Word window. The task pane provides easy access to commonly used menus, buttons, and tools. By 

default, the task pane will appear when Word XP is first launched. 

 

If you do not see your task pane, you can view it by either selecting certain commands or by manually 

opening it. 

To open the task pane: 
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• Click View in the menu bar. 

• Select Task Pane. 
 

 

Along the top bar of the task pane, you should see small backward and forward buttons on the left, as 

well as a down arrow on the right. To view different task panes available to you, click the down arrow. 

Once you have opened different task panes, you can navigate them by clicking the left and right arrow 

button on the left. To close your task pane, click the X symbol on the far-right of the bar. 
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Challenge!  

• Start Word. 

• Create a new document from the task pane. 

• Type the following: "This lesson taught me the basics of the Word XP window." 

• Change the document view to Web Layout View. 

• Exit Word without saving. 

Creating a New Document: 

Creating a document with Microsoft Word 

 

         In addition to working with existing documents, you will want to be able to create 
new documents. Each time you open Word, a new blank document appears; however, you 

will also need to know how to create new documents while an existing document is open.  

 
In this lesson, you will learn how to create new documents—including templates and blank 
documents—via the Microsoft Office button.  

To create a new blank document: 

• Click the Microsoft Office button. 

• Select New. The New Document dialog box appears. 

Select Blank document under the Blank and recent section. It will be highlighted by default 
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• Click Create. A new blank document appears in the Word window. 

You can access templates that are installed on your computer or on Office Online. Click the Microsoft 

Office button and select New. You can create blank documents and access templates from the dialog 

box that appears. 

New documents 

To use Microsoft Word to open a document, follow the steps below. 

Open Word in Windows 

1. Open Microsoft Word. If you're not sure how to open or 
find Word, skip to the finding Microsoft Word section. 

2. In newer versions of Word, the first screen asks what type 
of Word document you want to create. Select the "Blank 
document" option to create a document from scratch. You 
can also select from one of the Word templates provided if 
you would like to create a specific type of document. 
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3. Once the blank document or template is open, any new 
information can be entered using a keyboard or on-screen 
keyboard. 

4. Once complete or while working on the document, you can 
Save through the File tab at the top of the Word program 
window. 

Closing a Document in Word 

 we will understand how to close a document in Word 2010. When you finish working with a 
document, you will proceed to close the document. Closing a document removes it from your computer 
screen and if you had other documents open, Word displays the last document you used otherwise, you 
see a blank Word window. Here are simple steps to close an opened document − 

Step 1 − Click the File tab and select the Close option. 

 

 

Step 2 − When you select the Close option and if the document is not saved before closing, 
it will display the following Warning box asking whether the document should be saved or 
not. 
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Step 3 − To save the changes, click Save, otherwise click Don't Save. To go back to the document, 

click Cancel. This will close the document and if you have other documents open, Word displays the 

last document you used, otherwise, you see a blank Word window as shown below − 
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Moving and Copying Text in Microsoft Word 

Word enables you to cut and paste blocks of text from one part of a document to another. When you cut 
a selected portion of text, the text is removed from the document and placed on the Clipboard, a 
temporary storage area. When you paste text, a copy of the text on the Clipboard is placed into the 
document. The cut piece of text remains on the Clipboard until another block of text is placed on the 
Clipboard or until you shut down your computer. As long as the text remains on the clipboard, you can 
continue to paste the same text in different locations throughout your document. 

Bullets and Numbering 

           Bullets and numbering are most useful in creating ordered lists in your document. In this 
section of the tutorial we will cover the basics of both bulleted and numbered lists. 

Bullets: 

 

Step 1. To insert a bulleted list, click on the HOME tab, and under the Paragraph icon group on the 

ribbon menu, locate the Bullets icon. Click on the arrow beside it to reveal the drop-down menu, and 
select the kind of bullet you would like to use. If you just want to use a simple bullet, clicking on the 
button itself will create a simple bulleted list. 
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Step 2. Type the list, pressing Enter once to insert another bullet. When finished, simply 
press Enter twice. 
 
Numbering: 
         It often happens that a simple bulleted list is not what is called for in the context of the paragraph's 
subject matter (or the list itself may be too long). In which case, a numbered list might be more 
appropriate. 
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Step 1. Click on the HOME tab, and under the Paragraph icon group, locate the Numbered 

List icon. Click on the arrow beside it to reveal the drop-down menu, and select the kind of number or 
letter scheme you would like to use. As with bulleted lists above, clicking on the icon itself will create a 
simple numbered list. 

 

Step 2. Begin typing the numbered list, pressing Enter once to create a new entry within the list. When 
finished, simply press Enter twice. 

Formatting Lists: 

If at any time you want to change the format of your list, Word 2013 provides a variety of options. 
 
Formatting Bulleted Lists 

 

 



 

Step 1. To format a bulleted list, first select the list itself.

 

Step 2. Under the HOME tab, click on arrow beside the
select a new bullet from the drop-down menu. Notice that when you hover your mouse over the bullet, it 
will give you a preview of what the new bullet will look like in your list. 
listed, click on Define New Bullet. 

Formatting Numbered Lists 

Step 1. As above in bulleted lists, to format a numbered list, first select it.
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To format a bulleted list, first select the list itself. 

 

tab, click on arrow beside the Bullets icon in the Paragraph icon group, and 
down menu. Notice that when you hover your mouse over the bullet, it 

will give you a preview of what the new bullet will look like in your list. If the bullet you want isn't 

 

As above in bulleted lists, to format a numbered list, first select it. 

icon in the Paragraph icon group, and 
down menu. Notice that when you hover your mouse over the bullet, it 

If the bullet you want isn't 



 

Step 2. Then, under the HOME tab, click on the arrow beside the
drop-down menu, where you can select a different formatting. As with bulleted lists above, if you do not 
see a format that is to your liking, you may set your own custom scheme by selecting
Number Format. 
 
 

Insert date and time in Microsoft Word
1. Open Microsoft Word. 

2. Place the text cursor where you want to insert the date and 
time. 

3. Click the Insert tab in the Ribbon

4. On the Insert tab, click the 

5. Select the date or time format you want to insert in the 
document. If you want to have this information 
automatically updated, you can che
automatically box. 
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tab, click on the arrow beside the Numbered List

down menu, where you can select a different formatting. As with bulleted lists above, if you do not 
see a format that is to your liking, you may set your own custom scheme by selecting

in Microsoft Word 

Place the text cursor where you want to insert the date and 

Ribbon. 

 Date & Time option. 

Select the date or time format you want to insert in the 
document. If you want to have this information 
automatically updated, you can check the Update 

Numbered List icon to reveal the 
down menu, where you can select a different formatting. As with bulleted lists above, if you do not 

see a format that is to your liking, you may set your own custom scheme by selecting Define New 
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5. Once you're done selecting the format, click OK to insert. 

Insert date and time in WordPad 
1. Open WordPad. 

2. Place the text cursor where you want to insert the date and 
time. 

3. On the Home tab, click the Date and time option. 

4. Select the date or time format you want to insert in the 
document. If you want to insert the date and time, insert the 
date first, then insert the time second 
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Insert date and time in other programs 

Other word processing and text programs may have a feature to insert 

the date and time in the document. If the feature is available, it's often 

found on the Home or Insert tab, in the Edit or Insert menu, or 

the right-click context menu. 

 

Insert date and time in Microsoft Word 
1. Open Microsoft Word. 

2. Place the text cursor where you want to insert the date and 
time. 

3. Click the Insert tab in the Ribbon. 

4. On the Insert tab, click the Date & Time option. 

5. Select the date or time format you want to insert in the 
document. If you want to have this information 
automatically updated, you can check the Update 

automatically box. 
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5. Once you're done selecting the format, click OK to insert. 

Insert date and time in WordPad 
1. Open WordPad. 

2. Place the text cursor where you want to insert the date and 
time. 

3. On the Home tab, click the Date and time option. 

4. Select the date or time format you want to insert in the 
document. If you want to insert the date and time, insert the 
date first, then insert the time second. 
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Insert date and time in other programs 

Other word processing and text programs may have a feature to insert 

the date and time in the document. If the feature is available, it's often 

found on the Home or Insert tab, in the Edit or Insert menu, or 

the right-click context menu. 

 

When you're working with longer documents, it can be difficult and time consuming to locate a specific 

word or phrase. Word can automatically search your document using the Find feature, and it allows you 

to quickly change words or phrases using Replace. 

Optional: Download our practice document. 

Watch the video below to learn more about using Find and Replace. 

To find text 

In our example, we've written an academic paper and will use the Find command to locate all instances 

of a particular word. 

1. From the Home tab, click the Find command. Alternatively, you can 
press Ctrl+F on your keyboard. 
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2. The navigation pane will appear on the left side of the screen. 

3. Type the text you want to find in the field at the top of the navigation pane. In 
our example, we'll type the word we're looking for. 

 

4. If the text is found in the document, it will be highlighted in yellow and 
a preview of the results will appear in the navigation pane. Alternatively, you 
can click one of the results below the arrows to jump to it. 
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5. When you are finished, click the X to close the navigation pane. The highlight 

will disappear. 

 

For more search options, click the drop-down arrow next to the search field. 
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To replace text 

At times, you may discover that you've made a mistake repeatedly throughout your document—such as 

misspelling a person's name—or that you need to exchange a particular word or phrase for another. You 

can use Word's Find and Replace feature to quickly make revisions. In our example, we'll use Find and 

Replace to change the title of a magazine so it is abbreviated. 

1. From the Home tab, click the Replace command. Alternatively, you can 
press Ctrl+H on your keyboard. 
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2. The Find and Replace dialog box will appear. 

3. Type the text you want to find in the Find what: field. 

4. Type the text you want to replace it with in the Replace with: field. Then 
click Find Next. 

 

5. Word will find the first instance of the text and highlight it in gray. 

6. Review the text to make sure you want to replace it. In our example, the text is 
part of the title of the paper and does not need to be replaced. We'll click Find 

Next again to jump to the next instance. 
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7. If you want to replace it, you can click Replace to change individual instances 
of text. Alternatively, you can click Replace All to replace every instance of 
the text throughout the document. 
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8. The text will be replaced. 

 

9. When you're done, click Close or Cancel to close the dialog box. 

For more search options, click More in the Find and Replace dialog box. From here, you can select 

additional search options, such as matching case and ignoring punctuation. 

 

When it comes to using Replace All, it's important to remember that it could find matches you didn't 

anticipate and that you might not actually want to change. You should only use this option if you're 

absolutely sure it won't replace anything you didn't intend it to. 

Headers and Footers: 

  The header is a section of the document that appears in the top margin, while the footer is a section 

of the document that appears in the bottom margin. Headers and footers generally contain additional 

information such as page numbers, dates, an author's name, and footnotes, which can help keep 
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longer documents organized and make them easier to read. Text entered in the header or footer will 

appear on each page of the document. 

Optional: Download our practice document. 

Watch the video below to learn more about headers and footers in Word. 

To create a header or footer: 

In our example, we want to display the author's name at the top of each page, so we'll place it in the 

header. 

1. Double-click anywhere on the top or bottom margin of your document. In our example, 
we'll double-click the top margin. 

 

 

2. The header or footer will open, and a Design tab will appear on the right side of 
the Ribbon. The insertion point will appear in the header or footer. 
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3. Type the desired information into the header or footer. In our example, we'll type the 
author's name and the date. 

 

4. When you're finished, click Close Header and Footer. Alternatively, you can press 
the Esc key. 



 

5. The header or footer text will appear.

To insert a preset header or footer: 

Word has a variety of preset headers and footers

layout. In our example, we'll add a preset header to our document.

1. Select the Insert tab, then click the
click the Header command. 

2. In the menu that appears, select the desired

63 

The header or footer text will appear. 

 

t headers and footers you can use to enhance your document's design and 

layout. In our example, we'll add a preset header to our document. 

tab, then click the Header or Footer command. In our example, we'll 
 

the menu that appears, select the desired preset header or footer. 

 

 

you can use to enhance your document's design and 

command. In our example, we'll 
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3. The header or footer will appear. Many preset headers and footers contain text 
placeholders called Content Control fields. These fields are good for adding 
information like the document title, author's name, date, and page number. 

 

4. To edit a Content Control field, click it and type the desired information. 
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5. When you're finished, click Close Header and Footer. Alternatively, you can press 
the Esc key. 

 

If you want to delete a Content Control field, right-click it and select Remove Content Control from 

the menu that appears. 

 

Editing headers and footers 

After you close the header or footer, it will still be visible, but it will be locked. Simply double-click a 

header or footer to unlock it, which will allow you to edit it. 
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Design tab options 

When your document's header and footer are unlocked, the Design tab will appear on the right side of 

the Ribbon, giving you various editing options: 

• Hide the first-page header and footer: For some documents, you may not want the first 
page to show the header and footer, like if you have a cover page and want to start the 
page numbering on the second page. If you want to hide the first-page header and footer, 
check the box next to Different First Page. 

 

• Remove the header or footer: If you want to remove all information contained in the 
header, click the Header command and select Remove Header from the menu that 
appears. Similarly, you can remove a footer using the Footer command. 
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• Page Number: You can automatically number each page with the Page Number 
command. Read our Page Numbers lesson to learn more. 

 

• Additional options: With the commands available in the Insert group, you can add 
the date and time, document info, pictures, and more to your header or footer. 
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To insert the date or time into a header or footer: 

Sometimes it's helpful to include the date or time in the header or footer. For example, you may want 

your document to show the date when it was created. 

On the other hand, you may want to show the date when it was printed, which you can do by setting it 

to update automatically. This is useful if you frequently update and print a document because you'll 

always be able to tell which version is the most recent. 

1. Double-click anywhere on the header or footer to unlock it. Place the insertion 

point where you want the date or time to appear. In our example, we'll place the 
insertion point on the line below the author's name. 

 

2. The Design tab will appear. Click the Date & Time command. 

 

3. The Date and Time dialog box will appear. Select the desired date or time format. 

4. Check the box next to Update Automatically if you want the date to change every time 
you open the document. If you don't want the date to change, leave this option 
unchecked. 
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5. Click OK. 

 

6. The date will appear in the header. 

 

When you're working on a multi-page document, there may be times when you want to have more 

control over how exactly the text flows. Breaks can be helpful in these cases. There are many types of 

breaks to choose from depending on what you need, including page breaks, section breaks, 

and column breaks. 

Optional: Download our practice document. 

Watch the video below to learn more about using breaks in Word. 
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To insert a page break: 

In our example, the section headers on page three (Monthly Revenue and By Client) are separated from 

the table on the page below. And while we could just press Enter until that text reaches the top of page 

four, it could easily be shifted around if we added or deleted something in another part of the document. 

Instead, we'll insert a page break. 

1. Place the insertion point where you want to create the page break. In our example, we'll 
place it at the beginning of our headings. 

 

2. On the Insert tab, click the Page Break command. Alternatively, you can 
press Ctrl+Enter on your keyboard. 

 

3. The page break will be inserted into the document, and the text will move to the next 
page. 
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By default, breaks are invisible. If you want to see the breaks in your document, click 

the Show/Hide command on the Home tab. 

 

Section breaks 

Section breaks create a barrier between different parts of a document, allowing you to format each 

section independently. For example, you may want one section to have two columns without adding 

columns to the entire document. Word offers several types of section breaks. 

• Next Page: This option inserts a section break and moves text after the break to the next 
page of the document. 
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• Continuous: This option inserts a section break and allows you to continue working on 
the same page. 

• Even Page and Odd Page: These options add a section break and move the text after the 
break to the next even or odd page. These options may be useful when you need to begin 
a new section on an even or odd page (for example, a new chapter of a book). 

 

To insert a section break: 

In our example, we'll add a section break to separate a paragraph from a two-column list. 

1. Place the insertion point where you want to create the break. In our example, we'll place 
it at the beginning of the paragraph we want to separate from two-column formatting. 

 

2. On the Page Layout tab, click the Breaks command, then select the desired section 
break from the drop-down menu. In our example, we'll select Continuous so our 
paragraph remains on the same page as the columns. 
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3. A section break will appear in the document. 

 

4. The text before and after the section break can now be formatted separately. In our 
example, we'll apply one-column formatting to the paragraph. 
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5. The formatting will be applied to the current section of the document. In our example, 
the text above the section break uses two-column formatting, while the paragraph below 
the break uses one-column formatting. 

 

Other types of breaks 

When you want to format the appearance of columns or modify text wrapping around an image, Word 

offers additional break options that can help: 

• Column: When creating multiple columns, you can apply a column break to balance the 
appearance of the columns. Any text following the column break will begin in the next 
column. To learn more about how to create columns in your document, visit our lesson 
on Columns. 

• Text wrapping: When text has been wrapped around an image or object, you can use a 
text-wrapping break to end the wrapping and begin typing on the line below the image. 
Review our lesson on Pictures and Text Wrapping to learn more. 

 

To delete a break: 
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By default, breaks are hidden. If you want to delete a break, you'll first need to show the breaks in your 

document. 

1. On the Home tab, click the Show/Hide command. 

 

2. Locate the break you want to delete, then place the insertion point at the beginning of 
the break. 

3. Press the Delete key. The break will be deleted from the document. 

AutoCorrect 

Microsoft Office provides features which help to reduce typing errors whilst you work. AutoCorrect is 
one of those features and is set up by default to correct common spelling and punctuation errors. Errors 
including irregular capitalisation, or commonly misspelt words are corrected as you type. There are 
hundreds of pre-configured corrections already set up for you. As a little test, type acheive and you will 
see it automatically corrects to achieve. AutoCorrect is also responsible for converting some symbols 
automatically. For example type (c) into a document and it will automatically change to the copyright 
symbol. 

The reason I love AutoCorrect is that I can take advantage of this feature by adding my own entries into 
the AutoCorrect list. In addition to correcting common spelling mistakes, I take this a step further and 
use it in a way which is “outside the box”. How many times a day do you type your own name, business 
name, website address or even colleagues names? This is where I let AutoCorrect do the work for me! 
To achieve this I have allocated those common words or phrases with an abbreviation. I then set these 
up so that whenever I type the abbreviation, AutoCorrect changes it to the full name or phrase I have 
specified. No more typing my own name! 
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AutoCorrect is available across all Microsoft Office programs however only a few of them give you 
access to the interface to make changes. In this example, I am going to use Microsoft Word to create my 
own Autocorrect entries. 

Create an AutoCorrect entry 

1. Open Microsoft Word and make sure a document is displayed 
2. Select the File tab and choose Options 
3. The Word Options dialog box will appear: 
4. Select the Proofing option from the categories on the left-hand panel 
5. Now click the AutoCorrect Options button 
6. The AutoCorrect dialog box will appear 
7. Place your cursor in the Replace text box and type your initials. 

 

Grammar Check 

By default, Grammar Check is on whenever Word is open. When you turn this feature off, Grammar 

Check will not run as you work on your document. You can also grammar check a document after you 
are finished typing. 

1. From the Tools menu, select Spelling and Grammar... 
OR 

Press [Option]+[Command]+[L]. 
The Spelling and Grammar dialog box appears. 

NOTES: 

The Spelling and Grammar dialog box appears only if Word detects spelling or grammar errors. 
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2. To deactivate Automatic Grammar Check, deselect Check grammar. 
To activate Automatic Grammar Check, select Check grammar. 
NOTE: The option is selected if a checkmark appears in front of it. 

3. To exit the Spelling and Grammar dialog box, click Cancel. 

Correcting Grammar 

When Grammar Check finds a sentence that appears to have improper grammar, the possible error will 
be underlined with a wavy green line. You can correct mistakes through the Quick menu or through a 
dialog box. If an error has no clear solution, Word displays the grammatical rule being violated. 

Correcting Grammar: Quick Menu Option 

Using the Quick menu to access correction options allows you to manage grammar mistakes quickly and 
easily. 

1. [Control] + click the grammatical error. 
The Quick Menu appears. 

 

2. Select the appropriate option. 

Help 
Opens Microsoft Word 2008 Help. 

Suggestion 
Changes the highlighted error to the suggested correction. 

Ignore 
Ignores the highlighted error. 

Grammar... 
Opens the Spelling and Grammar dialog box. 

Correcting Grammar: Dialog Box Option 
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Using the dialog box option is a little more time-consuming, but you have more options for correcting 
grammatical errors. 

1. From the Tools menu, select Spelling and Grammar... 
OR 

Press [Option]+[Command]+[L]. 
The Spelling and Grammar dialog box appears. 

NOTES: 

The Spelling and Grammar dialog box appears only if Word detects spelling or grammar errors. 

 

2. Select the desired option: 

Ignore 
Ignores the highlighted error. 

Ignore All 
Ignores all occurrences of the highlighted error. 

Next Sentence 
Skips to the next grammatical error. 

Change 
Changes the error to the selected suggestion. 

4. When Spelling and Grammar Check is finished, in the dialog box that appears, click OK. 

Spelling and Grammar Options 
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The Spelling and Grammar options dialog box allows you to customize the spelling and grammar check 
function. You can specify an array of preferences including which words you want the function to 
ignore, what dictionary the function uses as a reference, and whether or not the function checks the 
document as you type. 

1. From the Tools menu, select Spelling and Grammar... 
OR 
Press [Option]+[Command]+[L]. 
The Spelling and Grammar dialog box appears. 
NOTES: 

The Spelling and Grammar dialog box appears only if Word detects spelling or grammar errors. 

2. At the bottom of the Spelling and Grammar dialog box, click Options... 
The Spelling and Grammar options dialog box appears. 

 

3. Select the desired options. 

4. Click OK. 

5. Click Cancel. 

OR 
Click Close. 

Creating and Using Templates 

To create a template in Word 2010, 

1. Open a blank Word document and adjust your styles (see page 5), margins (see page 8), and any 
automatic numbering features you want in your document. 
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2. In the File Ribbon, select Save as…, then select Word Template.  Save it somewhere that you 
can find easily. 

3. To modify your template later, open Word first, then open the template file – if you double-click 
on it, it will create a new document based on the template as described below. 

To create a template in Word 2013 or later, 

1. Adjust your styles, margins, etc. in a BLANK document. 
2. In the File Ribbon, select Save As, then click on the Browse button. A dialogue box will come 

up. The Save as Type dropdown defaults to .docx. In order to save the file as a template, you can 
use either the .dotx or .dotm format. Unless you are using macros in your document, choose 
the .dotx option. 

To create a document from your template or apply it to an existing document, 

1. Double-click on the template file you created in the steps above.  This will open a new document 
based on that template. 

2. If you already have a chapter written, you can insert that chapter into this new document to apply 
any style settings to it.  To do this… 

o On the Insert Ribbon, in the Text Group, click on the arrow next to the Object icon and 
select Text from File…. 

o Navigate to the document you wish to insert and click Insert. 

 

Mail merge 

Mail merge is a feature within most data processing applications that enables users to send a similar 
letter or document to multiple recipients. It enables connecting a single form template with a data source 
that contains information about the recipient’s name, address and other predefined and supported data. 

 



81 

 

T H E  A D V A N T A G E S  O F  M A I L  M E R G E  F O R  M I C R O S O F T  W O R D :  

� Time saving as it does lots of letters 
� It is simple and easy to use. 
� Easy to store the information. 
� Only one letter needed to be created. 

� You can edit as you like 

� Conditional formatting or options 

� It makes your work neater and professional 
  

Disadvantages of Mail Merge: 

•The letter sounds generic to the customer. 

•Information in the database needs to be kept up to date. 

•Mail merge is used for fraudulent purposes and for junk mail. 

•If you edit the database it can cause it to fail. 

•It’s easy to make mistakes. 

 

 

UNIT-III 

      Microsoft Excel has the basic features of all spreadsheets, using a grid of cells arranged in 
numbered rows and letter-named columns to organize data manipulations like arithmetic operations. It 
has a battery of supplied functions to answer statistical, engineering, and financial needs. In addition, it 
can display data as line graphs, histograms and charts, and with a very limited three-dimensional 
graphical display. It allows sectioning of data to view its dependencies on various factors for different 
perspectives (using pivot tables and the scenario manager). It has a programming aspect, Visual Basic 

for Applications, allowing the user to employ a wide variety of numerical methods, for example, for 
solving differential equations of mathematical physics, and then reporting the results back to the 
spreadsheet. It also has a variety of interactive features allowing user interfaces that can completely hide 
the spreadsheet from the user, so the spreadsheet presents itself as a so-called application, or decision 

support system (DSS), via a custom-designed user interface, for example, a stock analyzer, or in general, 
as a design tool that asks the user questions and provides answers and reports. In a more elaborate 
realization, an Excel application can automatically poll external databases and measuring instruments 
using an update schedule,analyze the results, make a Word report or PowerPoint slide show, and e-mail 
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these presentations on a regular basis to a list of participants. Excel was not designed to be used as a 
database 

Features of Microsoft Excel 

1. Add Header and Footer 
MS Excel allows us to keep the header and footer in our spreadsheet document. 
2. Find and Replace Command 
MS Excel allows us to find the needed data (text and numbers) in the workbook and also replace the 
existing data with a new one. 
3. Password Protection 

It allows the user to protect their workbooks by using a password from unauthorized access to their 
information. 
4. Data Filtering 
Filtering is a quick and easy way to find and work with a subset of data in a range. A filtered range 
displays only the rows that meet the criteria you specify for a column. MS Excel provides two 
commands for filtering ranges: 
           • AutoFilter; which includes filter by selection, for simple criteria 
           • Advanced Filter; for more complex criteria 
5. Data Sorting 
Data sorting is the process of arranging data in some logical order. MS Excel allows us to sort data 
either in ascending or descending order. 
6. Built-in formulae 
MS Excel has got many built-in formulae for sum, average, minimum, etc. We can use those formulae 
as per our needs. 
7. Create different charts (Pivot Table Report) 
MS Excel allows us to create different charts such as bar graph, pie- charts, line graphs, etc. This helps 
us to analyze and compare data very easily. 
8. Automatically edits the result 
MS Excel automatically edits the result if any changes are made in any of the cells. 
9. Formula Auditing 
Using formula auditing we can graphically display or trace the relationships between cells and formulas 
with blue arrows. We can trace the precedents (the cells that provide data to a specific cell) or the 
dependents (the cells that depend on the value in a specific cell). 

The Excel window 

Many items you see on the Excel XP screen are standard in most other Microsoft software programs like 

Word, PowerPoint, and previous versions of Excel, while some elements are specific to Excel XP. 
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Workbook 

Also called a spreadsheet, the workbook is a unique file created by Excel XP. 

Title bar 

 

The title bar displays both the name of the application and the name of the spreadsheet. 

Menu bar 

 

The menu bar displays all of the menus available for use in Excel XP. The contents of any menu can be 

displayed by left-clicking the menu name. 

Toolbar 

Some commands in the menus have pictures or icons associated with them. These pictures may also 

appear as shortcuts in the toolbar. 
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Column headings 

 

Each Excel spreadsheet contains 256 columns. Each column is named by a letter or combination of 

letters. 

Row headings 

 

Each spreadsheet contains 65,536 rows. Each row is named by a number. 

Name box 

 

This shows the address of the current selection or active cell. 

Formula bar 

 

The formula bar isplays information entered—or being entered as you type—in the current or active cell. 

The contents of a cell can also be edited in the formula bar. 
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Cell 

 

A cell is an intersection of a column and row. Each cell has a unique cell address. In the picture above, 

the cell address of the selected cell is B3. The heavy border around the selected cell is called the cell 

pointer. 

Navigation buttons and sheet tabs 

 

Navigation buttons allow you to move to another worksheet in an Excel workbook. They are used to 

display the first, previous, next, and last worksheets in the workbook. 

Sheet tabs separate a workbook into specific worksheets. A workbook defaults to three worksheets. A 

workbook must contain at least one worksheet. 

Workbooks and worksheets 

A workbook automatically shows in the workspace when you open Microsoft Excel XP. Each 

workbook contains three worksheets. A worksheet is a grid of cells consisting of 65,536 rows by 256 

columns. Spreadsheet information—text, numbers, or mathematical formulas—is entered into different 

cells. 
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Column headings are referenced by alphabetic characters in the gray boxes that run across the Excel 

screen, beginning with column A and ending with column IV. 

Rows are referenced by numbers that appear on the left and then run down the Excel screen. The first 

row is named row 1, while the last row is named 65536. 

Important terms 

• A workbook is made up of three worksheets. 

• The worksheets are labeled Sheet1, Sheet2, and Sheet3. 

• Each Excel worksheet is made up of columns and rows. 

• In order to access a worksheet, click the tab that says Sheet#. 

The cell 

An Excel worksheet is made up of columns and rows. Where these columns and rows intersect, 

they form little boxes called cells. The active cell—or the cell that can be acted upon—reveals a dark 

border. All other cells reveal a light gray border. Each cell has a name. Its name is comprised of two 

parts: the column letter and the row number.
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In the following picture, the cell C3—formed by the intersection of column C and row 3—contains the 

dark border. It is the active cell. 

 
 

Important terms 

• Each cell has a unique cell address composed of a cell's column and row. 

• The active cell is the cell that receives the data or command you give it. 

• A darkened border, called the cell pointer, identifies it. 

Moving around the worksheet 

You can move around the spreadsheet in several ways. 

To move the cell pointer: 

• To activate any cell, point to a cell with the mouse and click. 

• To move the pointer one cell to the left, right, up, or down, use the keyboard arrow keys. 

To scroll through the worksheet: 

The vertical scroll bar located along the right edge of the screen is used to move up or down the 

spreadsheet. The horizontal scroll bar located at the bottom of the screen is used to move left or right 

across the spreadsheet. 
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The PageUp and PageDown keys on the keyboard are used to move the cursor up or down one screen at 

a time. Other keys that move the active cell are Home, which moves to the first column on the current 

row, and Ctrl+Home, which moves the cursor to the top-left corner of the spreadsheet, or cell A1. 

To move between worksheets: 

As mentioned, each workbook defaults to three worksheets. These worksheets are represented by tabs—

named Sheet1, Sheet2 and Sheet3—that appear at the bottom of the Excel window. 

To move from one worksheet to another: 

• Click the sheet tab—Sheet1, Sheet2 or Sheet 3—you want to display. 
 

 

 

Save As Text 

1. Click on the "File" tab in the Microsoft Excel ribbon. ... 

2. Click on the "Save as Type" drop-down menu and select "Text (Tab Delimited)." Choose a location for 
your text file and save your current worksheet in TXT format. 

3. Switch to Microsoft Word. ... 

4. Select the text you exported from Excel. 

1. In Excel, select the embedded chart or chart sheet that you want to copy to a Word document. 
2. Select the Home tab then from the Clipboard group click the Copy button. 
3. In the Word document, click where you want to paste the copied chart. 
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4. Select the Home tab then from the Clipboard group click Paste. 
5. Either 

 
Click Paste Options Button image next to the chart: 

 

you will see five options. You can choose to embed or link the chart and you can choose destination 

theme or source formatting as well as picture 

1. if you embed the chart it is no longer linked to Excel 
2. if you link the chart then updates within Excel will affect the chart in your Word 

document 
3. source formatting keeps any formatting options set in Excel 
4. destination theme will allow changes to the look of the chart based on settings in the 

Word document 
5. picture will paste the chart as a graphic 

  

Opening/Closing a Workbook 

Creating a workbook 

A blank workbook is displayed when Microsoft Excel XP is first opened. You can type information or 

design a layout directly in this blank workbook. 

To create an Excel workbook: 
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• Choose File New from the menu bar. 
 

 

• The New Workbook task pane opens on the right side of the screen. 
 

 

• Choose Blank Workbook under the New category heading. 

• A blank workbook opens in the Excel window. The New Workbook task pane is 
closed. 

Saving a workbook 

Every workbook created in Excel must be saved and assigned a name to distinguish it from other 

workbooks. The first time you save a workbook, Excel will prompt you to assign a name through 

the Save As operation. Once the file is assigned a name, any additional changes made to the text, 

numbers, or formulas must be saved using the Save operation. 

To save a new workbook: 
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• Choose File Save As from the menu bar. 
 

 

• The Save As dialog box appears. 

• Click the Save In: drop-down menu and locate where the file will be saved. 
Choose 3 1/2 Floppy (A:) to save the file to a floppy disk or Local Disk (C:) to 
save the file to your computer. 

• Type a name for your file in the File Name: box. 

• Click the Save button. 
 

 

To save changes made to an existing workbook: 

• Choose File Save from the menu bar. 
OR 

• Click the Save button on the Standard toolbar. 

If you're saving the file for the first time and do not choose a file name, Microsoft Excel will assign a 

file name for you. 
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It is a good idea to save frequently when working in a spreadsheet. Losing information is never fun! 

You can quickly save your spreadsheet by using the quick-key combination Ctrl+S. 

Opening a workbook 

You can open any workbook that has previously been saved and given a name. 

To open an existing Excel  workbook: 

• Choose File Open from the menu bar. 
 

 

• The Open dialog box opens. 
 

 

• In the Look in list, click the drive, folder, or Internet location that has the file you 
want to open. 
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• In the folder list, open the folder that contains the file. Once the file is displayed, 
click the file you want to open. 

• Click the Open button. 

Closing a workbook 

To close an existing Excel  workbook: 

• Choose File Close from the menu bar. The workbook in the Excel window is 
closed. 

 

 

Excel  will prompt you to save information if anything has been typed between the last save and the time 

you close the file. 

How to delete a worksheet from a workbook 
1. In the sheet tab listing, right-click the worksheet you want 

to delete. 

2. From the right-click menu that appears, click 
the Delete option. 

Enter text or a number in a cell 

1. On the worksheet, click a cell 

2. type the numbers or text that you want to enter, and then press Enter or Tab.  
 
To enter data on a new line within a cell, enter a line break by pressing Alt+Enter.  

Cells & Ranges 

The location of a cell on a worksheet is given by its column letter and its row number (e.g. "A1"). This 
is often referred to as the Cell Address. 
All the cells on a worksheet are separated by grey lines, known as gridlines and a group of adjacent cells 
is known as a Range of cells. 
There are three types of cell reference operator that can be used to identify cells and ranges. The colon, 
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comma and the space. 
Colon ( : ) - This is used to define a range of cells (e.g. "A1:D4"). A range of cells is described in terms 
of the top left cell and the bottom right cell references separated by a colon. 
Comma ( , ) - This is used to define non adjacent cells (e.g. "A1", "B2"). The comma is also known as 
the union operator. 
Space ( ) - This is used to combine the intersection of two blocks of cells (e.g. "A1:D4 B2:C3"). When 
you use this operator the two blocks of cells must overlap. If not then an error message will appear. The 
space is also known as the intersection operator. 
Multiple cell ranges are commonly known as non adjacent or non contiguous ranges. These are ranges 
of cells that are not in a nice rectangular block. 

Entering data 

You can enter three different types of data into cells. This is sometimes expanded to four as some people 
class Dates & Times as a separate type. 
Numerical - These are basically numbers or values. This includes dates and times which are treated as 
serial numbers. This allows dates and times to be manipulated within formulas such as adding and 
subtracting dates. 
Text - These are basically words or any kind of text data. These are also known as labels or strings. Text 
entries are considered to be labels because you cannot perform any calculations on them. 
Formulas - These all start with an equal sign (=) and allow you to perform mathematical operations. 
If you select a cell and start typing you will over-write the contents of that cell. 
You can enter (and edit) the contents of cells either by using the formula bar or by using the cell 
directly. 
If you are not able to edit the contents in the cells directly then check your (Tools > Options)(Edit tab, 
"Edit directly in cell"). 

 
Selecting Data 

Before you can enter data into a cell you must select the cell first. 
There can be a number of cells selected on a worksheet at any one time but there will only ever be 
one Active Cell at any one time. 
The active cell is always surrounded by a black border. 
The address of the active cell is always displayed in the "Name Box" to the left of the Formula bar. 
When a range of cells is selected, only the upper left cell is considered to be the active cell. 
If a range of cells in selected then the active cell is identified as white. 
To deselect a cell or range of cells click anywhere outside the range or press any of the arrow keys. 
There are a large number of shortcut keys that can help you to select data and probably the most useful 
is (Ctrl + Shift + 8) which selects the current region. 

Moving data 

Whenever you copy cells, Excel stores the data in a temporary memory called the clipboard. 
The data will stay there until it is replaced by some other data. It will only get replaced with a 
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subsequent Cut or Copy command. 
The shortcut keys (Ctrl + C), (Ctrl + X) and (Ctrl + V) correspond to copying, cutting and pasting data 
respectively and are consistent with other applications. 
You can alternatively just press Enter to paste the current entry from the clipboard. 

Sorting data 

There are a number of ways you can sort and rearrange your data. 
You can sort by rows or columns into ascending and descending order. 
When you sort by rows the columns remain in the same order and the rows are rearranged. 
You can define your own custom sorting sequence regardless of their alphabetical sequence. 
It is important to remember that numerical values are sorted ahead of text values. 
There are four custom lists that exist by default and these contain days and months. If you sort by a 
column that contains entries from one of these four custom lists then they will be automatically sorted 
into the correct chronological order (i.e. Mon, Tue, Wed or Jan, Feb, Mar, etc). 
 

Deleting data 

When you want to erase the contents of a cell, use the (Edit > Clear) menu rather than deleting the actual 
cells. 
Alternatively you can press the Delete key. 
This will ensure your formulas and number formatting remains intact. 

Displaying Data 

Sometimes if a number starts with a negative sign then they are only displayed as a dash if the column 
width is not wide enough for the whole number. Just F2 the cell or convert it to a formula (prefix with an 
equals). 
If you have used row and column range names to provide a quick way to get parameters into worksheet 
functions, then "NUM!" is displayed although the correct value is obtained ?? 

Hiding Data from being Printed 

Need to produce a printout where certain cells (not an entire row or column, you could right-click and 
Hide them) in the print area need to be hidden? One trick is to set the font colour in those cells to white. 
Select the cells, (Format > Cells). In the Format Cells dialog box click the Font tab 
Click the arrow at the right side of the Color list box and select white from the list 
Click OK to close the dialog box and apply your new font colour 
Print the worksheet without showing the unwanted cells. After you finish printing, select the cells again 
and set the colour back to black (or automatic). 

Linking a Cell 
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You can reference a cell in another cell if you copy the cell. 
Select the cell you want to link and select (Edit > Paste Special > Paste Link). 

Adding Links 

You can copy a range of cells and paste a picture onto a worksheet. The picture is then updated 
automatically with any changes in values or formatting. Hold down the Shift key and select (Edit > Paste 
Picture Link). 

Important 

Excel treats numbers and text differently. Values are automatically aligned on the right and displayed in 
the general number format. Text is automatically aligned on the left. 
Copying cells will copy their values, formulas, formatting and comments. 
Cells cannot contain more than 32,000 characters. 

Formatting text and numbers 

1. Select the cells(s) you want to modify. Selecting a cell range. 

2. Click the drop-down arrow next to the Number Format command on the Home tab. The 
Number Formatting drop-down menu will appear. 

3. Select the desired formatting option. ... 

4. The selected cells will change to the new formatting style. 

 
AutoFill 

  

Use AutoFill in Excel to automatically fill a series of cells. This page contains many easy to follow 

AutoFill examples. The sky is the limit! 

1. For example, enter the value 10 into cell A1 and the value 20 into cell A2. 

Types  charts 

• Pie Chart 
• Column Chart 
• Line Chart 
• Bar Chart 
• Area Chart 
• Scatter Chart 
• Other Chart Types 
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Making of a Graph  
 

1. Enter your data into Excel. 

2. Choose one of nine graph and chart options to make. 

3. Highlight your data and 'Insert' your desired graph. 

4. Switch the data on each axis, if necessary. 

5. Adjust your data's layout and colors. 

6. Change the size of your chart's legend and axis labels. 

How to sort in Excel? 

1. Select a single cell in the column you want to sort. 

2. On the Data tab, in the Sort & Filter group, click. to perform an ascending sort (from A to Z, or 
smallest number to largest). 

3. Click. to perform a descending sort (from Z to A, or largest number to smallest). 
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UNIT-IV 

 

Microsoft Access: 

The Microsoft Access database is composed of 7 main components: 

• Forms 
• Macros 
• Modules 
• Queries 
• Relationships 
• Reports 
• Tables 

Primary Tasks: 

Microsoft Access works just like any other database. It stores related information and allows you to 
make connections (commonly referred to as relationships) between different things. 

Some of the main tasks done in Access include: 

• Create and maintain databases and their tables. 
• Configure rules and restrictions for the type of data that can enter into the database. 
• Build and run queries. 
• Create forms that allow non-technical users to enter data, search the database, and perform other 

tasks. 
• Generate reports so the data can be presented in a more readable format or sent via email, print, 

etc. 
• Create macros so that multi-step tasks can perform with a click of a button (or even when you 

open the database). 
• Import and export data from external sources (e.g., Excel spreadsheets, CSV files, etc.) 

 

Main advantages of Microsoft Access 

Relieved requirements for user knowledge. 

All employees at the office level can use a database with minimal training and learning effort: First class 
specialists are not required! 

Availability of visual development tools. 
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We all know that a book with images is much more enjoyable to read. You can say the same about the 
MS Access database. 

Translation to many languages. 

It is very convenient to use your mother tongue in computer programs. You will never confuse the word 
“ban” with the “bank”! 

Do you remember the situation when your father-in-law is at home, and you have no notes? MS Access 
offers a variety of tools to help beginners. 

File Extension 

When you create (and save) a database in Microsoft Access, the database saved with the .accdb 
extension. It is the file extension that you use most often when developing Access databases. Once 
you’ve set up your database, you can also save it as a single executable. A single executable uses the 
.accde extension. 

 

Comparing Access with Other Databases 

Here are some notable features of Access compared to other databases: 

1. Microsoft Access uses its own database storage file. 

2. Access can use multiple backend sources. 

3. Access is an application that can use to create and manage databases on PC. You can use Access as a 
visualization tool to create forms and reports from the underlying data. 

4. MS Access can also be used as a “front-end” of a program, while other products act as “back-end” 
tables, p. B. MS SQL Server and non-Microsoft products, such as Sybase and Oracle. Similarly, some 
applications such as Visual Basic, ASP.NET, or Visual Studio .NET can use the Access database for 
their tables and database queries. 

5. Access can also be part of a complex solution that can be compatible with other applications and 
technologies such as Microsoft Excel controls, Microsoft Outlook, Microsoft Word, Microsoft 
PowerPoint, and ActiveX. 

The Benefits and Advantages of Microsoft Access 

• Quick and easy to create database systems. ... 

• Microsoft Access produces very user-friendly applications through its comprehensive programming 
language (VBA). ... 

• MS Access produces flexible and adaptable database systems. ... 

• Well-known so you can get help and support easily. 
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Microsoft Access Features; 

• Ideal for individual users and smaller teams. 

• Easier than client-server database to understand and use. 

• Import and export to other Microsoft Office and other applications. 

• Ready templates for regular users to create and publish data. 

• Allows building and publishing Web databases effortlessly. 

 

 

 

Components of Microsoft Access: 
Microsoft Access has been around for a long time, but some people are still uncertain as to what the 
program does and how it can benefit their day-to-day operations. Access is a relational database, and it 
has a similar look and feel to other Microsoft products. It’s made up of six major components, which we 
will discuss today. Even though there is plenty to read about MS Access, the only way to know for sure 
how you like the program is by trying it out for yourself! 
Let’s explore the six major components to Microsoft Access so that you can better understand how the 
database works. 
1. Tables 
Tables are responsible for storing information within the database. You will notice that the tables in 
Access look similar to the ones in Excel. They contain columns and rows. Each column has a name at 
the top, and each row has a number. 
If you don’t set up the tables correctly, the database might give you the wrong results. Improper tables 
can also lead to slow or unpredictable performance, so take your time setting up the tables appropriately. 
2. Relationships 
Relationships are essentially the “connections” or “bonds” that are formed between tables. Tables can be 
related in one of three ways: one-to-one, one-to-many and many-to-many. 
3. Queries 
Queries are requests for information. Queries can sort, calculate, filter, update data and more based on 
the results you are looking for. 
4. Forms 
According to Access, a form is a database object that can be used to create a user interface for a database 
application. A bound form is linked to a data source, whereas an unbound form does not. 
5. Reports 
Once you have data entered into the database, you can run reports to view, summarize or format various 
information. Reports cannot be edited as forms can, but you can pick and choose the information you 
want to compare before creating the report. 
 

6. Macros 
Macros perform a series of actions based on how you enter them. For example, you can create macros 
that will open forms, change values, run queries and even run other macros. Thanks to macros, you can 
automate certain tasks and improve efficiency when using the database. 
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Microsoft Access is a relatively easy database to learn, and it works well for both small and large 
applications. To discover more about this database solution and how it can benefit your business 
operations, schedule a FREE consultation with Ark ware. 

  

                          UNIT-V 

1. Ready made slides: -Since power point is having powerful wizards, we can prepare the slides easily 
and quickly. The auto content wizard option provides wizards to make the slides easily. The template 
provides a wide range of ready made designs to us. 
 
 
2. Background Colours and effects: -We can have a wide variety of background colours for slides in 
power point on addition to colours we can also get different textures and shades in slides. We can also 
change the colour of existing wizards and templates. 
 
 
3. Pictures: - Not only captions and different colours we can introduce good pictures either from clip art 
or from scanning the pictures. 
 
 
4. Sounds: -Different sounds can be created while presenting the various slides. The sounds will have a 
pleasing effect on the viewers. 
 
 
5. Animation: -Different animation techniques are also available in the slides. The letters and pictures 
will fly from top to bottom and from left to right. We can have many animating options, we can also get 
preview of various animation effects. 
 
 
6. Charts and tables:-We can insert different charts and tables for expressing the data and information 
to the users. The different charts and tables in the MS excel can be easily imported into MS power point. 
 
 
7. Time for slides: -We can prescribe the time automatically or manually for running and exhibiting 
slides. 
 
 
For example we can set the time for 5 or 6 second for each slide to exhibit on the computer. 
 
 

8.    Speaker Notes: - Speaker notes are the notes (other features) that can be included in the button of the 
slide so, that new ideas can be discussed during presentation. 
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Other Features: - 
 
MS power point includes many other features like macro’s changing the colors to the slides, font etc. 
We can also change the order of slides using slide sorter view. 
 
Advantages of power point: - 
 
There are many advantages of computerized presentation. 
 
 
1. The slides can be prepared for different types of audience i.e., literates, illiterates, children, old 
people etc.. 
 
 
2. They can be run automatically. There is no manual interference for running power point slide shows. 
 
 
3. There is no problem of getting slides out of order. 
 
 
4. We can take print outs of presentation and can be distributed to the audience.  
 
 
5. The audience will easily be attracted by the colourful slides with sound and animation techniques. 
 
 
6. The built in designed templates allow the people to create power full slides very easily. 
 
 

7. If we want to change a part of presentation, we need not change all the slides, we can change all 
slides by changing the master slide.  

The Parts of the PowerPoint Window 
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PARTS OF POWER POINT: 

The PowerPoint Window has toolbars and panes to help you quickly create presentations. Most of the 
toolbars are common in Office applications but may feature options unique to PowerPoint. 

·         Title Bar - displays the document name followed by a program name. 

·         Menu Bar - contains a list of options to manage and customize documents. 

·         Standard Toolbar - contains shortcut buttons for the most popular commands. 

·         Formatting Toolbar - contains buttons used for formatting. 

·         Status Bar - displays slide position and the type of design in PowerPoint. 

·         Drawing Toolbar - contains tools for drawing lines, shapes and objects. 

·         Task Pane - located on the right side of the computer screen, this pane allows you to select tasks in 
different categories and allows you to quickly enhance your slides in a few steps. It provides quick 
access to the most common actions and features in PowerPoint. 

·         Outline and Slides Tabbed Pane - allows the user to easily view the presentation in outline format 
(text), as well as a list of all the slides in the presentation (with visuals). 

·         Help - provides quick access to Help topics.  

Save a slide as a new PowerPoint presentation 
1. In the slide thumbnail tab, on the left side of the PowerPoint window, select the slide you want to save. 



 

Note: If you don’t see the Slide tab, click

2. 

3. Click File > New. Click Blank Presentation
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tab, click View > Normal. 

 On the Home tab select Copy. 
 

 
Blank Presentation. 

 



 

4. On the Home tab select Paste to open the drop
Formatting button. This will paste the slide into your new presentation as the second slide.

5. Select the blank slide in the new presentation. Press the Delete key.
6. Click File > Save. Navigate to the folder where you want t
7. Type the name of your slide image in the

Save a single slide as an image 

1. In the slide thumbnail pane, on the left side of the PowerPoint window, select the slide you want to save.
2. Click File > Save As (or Save a Copy

Navigate to the folder where you want to save your slide.
3. Type the name of your slide image in the
4. Click to open the Save as Type drop

slide. 

• Open a presentation 

• Insert a new slide 

• Copy a slide 

• Delete a slide 

Opening a presentation 

You can quickly open a presentation you've previously saved by using the task pane.

To open a presentation 

• Start PowerPoint. 
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to open the drop-down menu, and click the
button. This will paste the slide into your new presentation as the second slide.

. 

Select the blank slide in the new presentation. Press the Delete key. 
. Navigate to the folder where you want to save your slide. 

Type the name of your slide image in the File name text box. Click Save. 

In the slide thumbnail pane, on the left side of the PowerPoint window, select the slide you want to save.
Save a Copy if your presentation is saved on OneDrive or SharePoint). 

Navigate to the folder where you want to save your slide. 
Type the name of your slide image in the File name text box. 

drop-down menu. Select one of the following image formats for your 

You can quickly open a presentation you've previously saved by using the task pane.

menu, and click the Keep Source 

button. This will paste the slide into your new presentation as the second slide. 

In the slide thumbnail pane, on the left side of the PowerPoint window, select the slide you want to save. 
if your presentation is saved on OneDrive or SharePoint). 

llowing image formats for your 

You can quickly open a presentation you've previously saved by using the task pane. 
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• In the task pane, click From existing presentation and select the presentation you want 
to open. 

 

OR 

• Choose File Open. 

• Navigate to the file you want to open. 

Inserting a new slide 

Once you've created your opening slide, you'll want to add more slides to your presentation. 

To insert a new slide: 

• Click Insert New Slide (Ctrl+M). 

• Move your arrow pointer over layouts, or use the scroll bar and choose a slide layout. 
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• A gray bar appears on the right. 

• Click the down-pointing arrow, and choose Insert New Slide. 

OR 

• Click the New Slide button at the top of the screen. 

 

• Move your arrow pointer over layouts, or use the scroll bar and choose a design layout. 

• A gray bar appears on the right. 

• Click the down-pointing arrow, and choose Insert New Slide. 

Copying a slide 

Copying is another technique you can use as you work on your slide presentation. For example, you may 

want to repeat a slide later in the presentation or copy a slide and make slight changes to it to make a 

different point. 

To copy a slide: 

• Click the slide you want to copy in the pane on the left. 

• Click the Copy Button on the standard toolbar (Ctrl+C). 

• Move the arrow pointer to where you want the copied slide to appear. 

OR 

• Right click the slide you want to copy in the pane on the left. 

• Move the arrow pointer to where you want the copied slide to appear. 

• A horizontal cursor appears. 

• Click the Paste button on the standard toolbar, or right-click Paste (Ctrl+V). 
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Note: This example of how to copy a slide was shown in the Slide Sorter View; however, the same 

instructions apply for copying a slide in Normal View. 

Deleting a slide 

Sometimes you may want to take one or more slides out of your presentation. 

To delete a slide: 

• Click the slide. 

• Press Delete on your keyboard. 

OR 

• Right-click the slide you want to delete in the pane to the left Delete Slide. 
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You'll learn more about working with slides in different views in the next lesson. 

 

To open an existing presentation: 

1. Choose File > Open, or click the Open button on the toolbar. 

The Open dialog box appears. 

2. If necessary, choose a different disk or folder by navigating the dialog box as you would any 

standard Windows file dialog. 

3. Click the name in the list and click Open. 

PowerPoint supports multiple views to allow users to gain the maximum from the features available in 
the program. Each view supports a different set of functions and is designed accordingly. 

PowerPoint views can be accessed from two locations. 

• Views can be accessed quickly from the bottom bar just to the left of the zoom settings. 
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• Views can also be accessed from the Presentation Views section in the View ribbon 

 

Here is a short description of the various views and their features. 

Normal View 

This is the default view in PowerPoint and this is primarily used to create and edit slides. You can 
create/ delete/ edit/ rearrange slides, add/ remove/ modify content and manipulate sections from this 
view. 



111 

 

 

 

Slide Sorter View 

This view is primarily used to sort slides and rearrange them. This view is also ideal to add or remove 
sections as it presents the slides in a more compact manner making it easier to rearrange them. 
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Reading View 

This view is new to PowerPoint 2010 and it was created mainly to review the slideshow without losing 
access to rest of the Windows applications. Typically, when you run the slideshow, the presentation 
takes up the entire screen so other applications cannot be accessed from the taskbar. In the reading view 
the taskbar is still available while viewing the slideshow which is convenient. You cannot make any 
modifications when on this view. 

 

SlidesShow 

This is the traditional slideshow view available in all the earlier versions of PowerPoint. This view is 
used to run the slideshow during presentation. 

 



113 

 

 

Formatting in Powerpoint 

One of the most powerful tools in Microsoft Office is the application of formatting feature. This 
feature basically lets you define the right format once and apply the same to a series of objects in the 
rest of the presentation or any other file. While working with large presentations or just working on 
slides for a long time, if you ever need to make a change in the style and want it applied across multiple 
content this is the tool to use. 

The following are the steps to apply formatting to your presentation − 

Step 1 − Select the content you want to copy the formatting from. 

Step 2 − Go to the Clipboard group under the Home ribbon. 

 

 
 

Step 3 − Click on the Format Painter icon. 

 

Step 4 − Select the content you want to format. 
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Here are some key aspects about the Format Painter − 

• If you click on the Format Painter icon just once, the formatting will be copied just once. 

• If you click on the Format Painter icon twice quickly, you can copy the formatting multiple 
times. 

• If you want to copy just the text formatting and not the paragraph features, ensure that you select 
just the sample text and not the entire paragraph. 

• If you want to copy paragraph and font formatting, you must select the entire paragraph. 

•  
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Types of charts 

       Column charts use vertical bars to represent data. They can work with many different types of data, 
but they're most frequently used for comparing information. 

 
 

         Line charts are ideal for showing trends. The data points are connected with lines, making it easy 
to see whether values are increasing or decreasing over time. 
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Pie charts make it easy to compare proportions. Each value is shown as a slice of the pie, so it's 
easy to see which values make up the percentage of a whole. 

 

 

             Bar charts work just like column charts, but they use horizontal bars instead of vertical bars. 
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Area charts are similar to line charts, except the areas under the lines are filled in. 

 

 

              Surface charts allow you to display data across a 3-D landscape. They work best with large data 
sets, allowing you to see a variety of information at the same time. 
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Custom Animations 

It is possible to create perfectly good animations using the animation schemes it is also possible to create 
your own animations. 
It is possible to apply an animation to any object on the slide, whether it is a textbox, drawing object, 
picture etc. 
For text objects you can specify if the animation is to be applied to the text as a whole or to the 
individual paragraphs. 

Effects appears in the Custom Animation list, top to bottom, in the order you apply them. 
If you add diagram effect options, they will appear in a collapsed list under the effect that you applied to 
the chart. 
The animated items are noted on the slide by a non-printing numbered tag that correlates to the effects in 
the list. 
This tag appears only in normal view with the Custom Animation task pane displayed. 
You can also specify if the text is displayed letter by letter 
also whether the animation is activated by pressing Enter or automatically. 

Entrance Effect 

This is how the object will enter the slide. If you do not specify an entrance effect then the object will 
appear in the same position that it is on the slide. 

Appear - 
Blinds - 
Box - 
Checkerboard 
Diamond - 
Fly in 
Wipe - 

 
You can press More Effects to choose from the full list of 52 effects 

Emphasis Effect 

This lets you draw attention to an object that is already on a slide. 
There are 31 different types of emphasis that can be used. 

Change Font 
Change Font Size 
Change Font Style 
Grow/Shrink - 
Spin – 
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        Exit Effect   

This is how the object will leave the slide 
Most objects will not have an exit effect but there are a choice of 52. 

Blinds - 
Box - 
Checkerboard 
Diamond - 
Fly Out 

Each effect that you apply has one or more property settings that you can tweak in order to customise 
the effect. 
All the effects have a speed setting and some have additional settings that let you control the range of an 
objects animation (for example the Spin effect ??). 

You can preview an animation by selecting Play. 

In either case you must first add the effect for the text placeholder and then display the Effect Settings 
dialog box by clicking the down arrow next to the effect and selecting Effect Options 

 

Timing your animations 

Most animations are initiated by clicks of the mouse however it is possible to set up animations that are 
activated automatically. Either in a sequence or at the same time. 
The first step is to get the effect list in the correct order. 
SS 
Effects are added to the list in the order they are created and will not necessary be in the correct 
You can drag the effects up and down in the list. 
After you get the effects in the right order. Choose an option from the Start drop-down list that's near the 
top of the Custom Animation task pane to set the start option for each effect. 
This has three options: 
On Click - Starts the effect when you press the mouse or press Enter 
With Previous - Starts the effect when the effect immediately before it starts. This option lets you 
animate two objects at the same time. 
After Previous - Starts the effect when the effect immediately before it finishes. 
select each effect and select the type of start option. 
       If all the effects except the first is set to "After Previous" the entire slide animations will run 
automatically once the first animation is started by pressing Enter. 
 
                                           Important 
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The most common types of effects for each type are listed on the right of each menu. 
The effects number will appear on the slide (when in Normal view) but this will not be displayed during 
the slide show. 

                                           Transition: 

When referring to video or a slide, a transition is an effect that happens between each photo, slide, or 
video clip. For example, a fade transition can fade in or out of each picture in a slide show. 
Changing the transitions in Microsoft PowerPoint 

 

The transitions are adjusted in Microsoft PowerPoint by clicking the Transitions tab. Once in the 
Transitions section, you'll see each of the available Transitions and can click the down arrows to scroll 
through and view all available Transitions. Clicking any of the transitions give you an overview of the 
transition. Clicking Effect Options allows you to change the direction or other options of the 
effect. Sounds allow you to have a sound on each transition. Duration allows you to increase or 
decrease the duration or time of the effect. 

Examples of different types of transitions: 
There are several types of transitions that can be used in most programs. Below is an alphabetical listing 
of different types of transitions and what type of animation or effect they give your show. Keep in mind 
that not all of the below transitions will be available in every program that supports transitions. 

• Blinds - Horizontally or vertically flip over bars like slats in blinds to reveal next scene. 
• Box - Show overview of current scene and rotate as if it were inside a box to show next scene. 
• Checkerboard - Flip over checkerboard tiles to reveal next scene. 
• Clock - Reveal next scene in a clockwise or counterclockwise reveal. 
• Conveyor - Move current scene off screen while bringing in next scene like a conveyor belt. 
• Cover - Reveal an overview and then flip the next scene on top of the previous. 
• Cube - Display video as surface on a cube, and rotate the cube to reveal another scene. 
• Cut - Quick cut to the next scene. 

• Dissolve - Dissolve previous scene to reveal next scene. 

• Doors - Split the current scene and open as if it were a door to reveal next scene. 

• Fade - Fade (dissolve) in our out. 

• Ferris Wheel - Rotate out current scene followed by next scene in a circular motion like a Ferris wheel. 

• Flash - Camera flash effect to display next scene. 

• Flip - Show overview of current scene and flip it around to show next scene on its back. 
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• Fly through - Fly through the current scene to show next scene behind current scene, like zoom effect 

without removing background. 

• Gallery - Show overview of current slide and move to the next scene as if you were looking at art in a 

gallery. 

• Glitter - Dissolve and reveal next slide in an octagon glitter effect. 

• Honeycomb - Dissolve and reveal next slide in an octagon honeycomb pattern. 

• None - Remove or perform no transition, usually this is the default. 

• Orbit - Show overview of current scene and rotate it like Box effect but doesn't remove background. 

• Pan - Move the current scene in any direction with the next scene following behind. 

• Push - Move the side, picture, or video in the direction of the effect. 

• Random bars - Fade out and in with random horizontal or vertical bars. 

• Reveal - Fade out and then in with next scene in a direction of your choice. 

• Ripple - Create ripples like those in water to reveal next scene. 

• Rotate - Rotate the current scene to show the next scene like cube without removing the background. 

• Shape - Fade in or out in the shape of a circle, square, diamond or another shape. 

• Shred - Cut the current scene into pieces and move new cut pieces from next scene into view. 

• Split - Dissolve out from the middle or from the edges in depending on the options. 

• Switch - Show current and next scene and switch between the two like cards in a deck. 

• Uncover - Reveal an overview and then flip it away like a page in a book. 
• Vortex - Display hundreds of small squares in a tornado vortex effect to dissolve and reveal next scene 

• Window - Open the current scene and have the previous scene come through like door, but window 

doesn't remove background. 

• Wipe - Dissolve in the direction of the effect. 

• Zoom - Zoom in through the current scene to show next scene behind it 

 

 
 


